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everything.
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EDITORS’ PAGE

Read Me First
WARNING! Before you turn to page 35 in this
issue, you should know that what you will
ﬁnd on that page may shock you. Actually,
shock might be too mild a term. With a little
help from the Thesaurus capability of my
favorite Mac OS 10.4 utility, Dictionary.app,
let me speculate that what you’ll see there
might appall, horrify, outrage, revolt,
disgust, nauseate, sicken, traumatize,
distress, upset, disturb, disquiet, unsettle,
stun, stagger, astound, astonish, amaze,
startle, surprise, dumbfound, shake, throw, and otherwise unnerve you.
It’s a screenshot of Windows XP.
Yes, Windows. In MacAddict, a magazine that uses the pejoratives
Windoze and peecee. In a magazine written for dyed-in-the-wool Mac
fanatics by dyed-in-the-wool Mac fanatics. But there it is, in all its
garishness. But before you ﬁre off an emailed rebuke, let me explain.
First, a bit of history. When MacAddict ﬁrst appeared in 1996, we
Mac addicts and our beloved computers were—to use the technical
macroeconomic term—in deep doo-doo. Apple was adrift, Microsoft
was ascendant, and every prognosticator worth his or her punditry was
predicting that the Mac would soon go the way of the Amiga, the Trash80, and the Osborne Executive. Knowing that a good offense is often the
best defense, we fought back by ridiculing Microsoft every chance we got.
What a difference 10 years makes. Today, Apple is ﬁring on all
cylinders, and the Redmondese are on the ropes. Windows PCs are
clogged with viruses and spyware, and Microsoft engineers are frantically
issuing security updates while struggling to cobble together Windows
XP’s replacement, Vista, originally expected to ship in 2004 and now
postponed until 2007. (On a side note, how long would you keep your job
if you missed a deadline by, oh, about three years? Same here.)
And so, as tempting as it may be to gloat, we laid-back Mac addicts are
taking the high road. Like Apple, which recently made it possible to run
Windows XP on Intel-based Macs (see “Apple Opens Windows,” p10), we
realize that some luckless souls either must use a particular Windows app
or simply feel more comfortable having Windows around as an emotional
safety net. We will not heap scorn upon those poor unfortunates. We
welcome them into the holy land of Aqua and forgive them their Windows
dependency—and we’re here to provide you with some insight into their
predicament.
Thus page 35.

STAFF RANTS
Q. Will you install Windows on your Mac—and, if so, why?
Niko Coucouvanis WINDOW CHOPPER
Will you install Windows on your Mac—and, if so, why?
I already did. I can’t very well keep chanting my
“#*@& Windows!” mantra without having suffered that
operating system since its Windows 95 version, can I?
And now, having Microsofted my Mac, I can now feel conﬁdent about
stating, “#*@& Windows XP!”

Sean Molloy PLAYER ONE
Will you install Windows on your Mac—and, if so, why?
As a card-carrying, diehard gamer, this whole Boot Camp
thing neatly resolves the only major issue I ever had with
the Mac: its anemic (and painfully outdated) game library.
So my answer is “Hell yeah!”—at least once the more-potent Intel
Power Macs (or whatever Apple decides to call ’em) come out.

Jake Widman HERD MENTALITY
Will you install Windows on your Mac—and, if so, why?
Heck yes. I feel left out when I read all those articles
about adware and spyware and Melissa and Sober. I’ve
been missing a big part of American culture—it’s like
not knowing who Ryan Seacrest is. (Who the hell is Ryan Seacrest,
anyway?) I want to be part of the crowd. Bring it on!

Roman Loyola GOES BOTH WAYS
Will you install Windows on your Mac—and, if so, why?
Brace yourself, fellow Mac addicts: In addition to my
Mac, I already have a PC with Windows XP running on
it. Why? It’s a self-serving career move. Having expert
knowledge of different operating systems has helped me immensely
as an editor.

Mark Rosenthal I.N.O. ECKSPEA
Will you install Windows on your Mac—and, if so, why?
I’m no übergeek. I’m an Art Director—who, even after
asking Niko about a gazillion questions, was still barely
able to install wireless Internet in my house. Install
Windows? What do you think?

Peter Marshutz PAGE MAKER
Will you install Windows on your Mac—and, if so, why?
I’m an art guy. At every magazine I’ve ever worked—in
fact, at every magazine I’ve ever heard of—all the
creative types have used Macs since the long-gone
days of Aldus PageMaker. Will I install Windows on my Mac?
Whatever for?

Max DOG(COW)MATIST
Will you install Windows on your Mac—and, if so, why?
Will I poke myself in the eye with a sharp stick? Will I
chugalug a Clorox-and-Drano smoothie? Will I drive the
Pan-American Highway in a secondhand Yugo? Will I
accept a position at the Baghdad Ministry of Tourism? Let Rik take
the high road of inclusion and tolerance—no Microsoft operating
system will ever sully the sectors of my Mac’s hard drive!

Enjoy,

comingsoon:july2006
Here’s what our editors are preparing for the next issue of MacAddict.

Next month we’ll delve deep into the bowels of Mac OS X and revel in its hidden powers. We’ll also round up a herd of
affordable Microsoft Word competitors, plus show you how to solve your Mac’s ills through the relentless application of
logic. Then we’ll show you how—and why—to maximize your Mac mini’s RAM, score your home movies in GarageBand,
and spread the blasphemy du jour by infecting your Mac with Windows XP. We’ll also review the hottest new products,
including Adobe After Effects 7 visual-effects software, Native Instruments’ B4II virtual organ, Kodak’s EasyShare P880
camera, Adobe Photoshop Elements 4 image-editing software, and more.
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the news of the month in bite-size chunks

FIRST LOOK:

APPLE
OPENS
WINDOWS
Apple’s new Boot Camp allows you to do
the unthinkable—run Windows XP on your
Intel-based Mac. We’ve got the gory details.

F

our days after its 30th
anniversary on April Fools’
Day, Apple released a beta
of Boot Camp, software
that lets you install and
run Windows XP on Intel-based
Macs. It was a surprising move, since
Apple spokespeople stated when the
company originally announced the
Intel-hardware switch that it had no
plans to support Windows on Macs.
Literally speaking, that’s true: Boot
Camp’s setup guide says that Apple
doesn’t provide support for either
Windows or the Boot Camp beta—
supporting Windows and being able to
run Windows are two different things.
Boot Camp preps your Mac’s hard
drive for a Windows XP installation;
it sets up your Mac as a dual-boot
computer, letting you choose between
Mac OS X or Windows XP at startup.
Keep your eye out for the July 2006
issue of MacAddict, where we’ll give you
in-depth details on using Boot Camp,
installing Windows XP, and how to make
sure your new, dual-boot Mac runs
smoothly.
First look. Available for download
from Apple’s Web site (www.apple.com/
macosx/bootcamp; it’s 86MB, so if you
start downloading it now, it’ll probably
10
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be ﬁnished by the time you’re done
with this article), Boot Camp requires
an Intel-based Mac, Mac OS 10.4.6 or
later, updated ﬁrmware on your Mac
(get ﬁrmware updates at www.apple
.com/support/downloads), a minimum of
10GB of free space on your Mac’s internal
drive, a blank recordable CD, and the
full installation discs for either the Home
or Professional Edition of Microsoft
Windows XP with Service Pack 2 (SP2);
you can’t use multi-disc, upgrade, or
Media Center versions of XP, nor can
you use pre-SP2 versions of XP. Apple
doesn’t provide or sell Windows XP with
Service Pack 2, so you need to buy it on
your own—go ahead, visit the Windowssoftware side of your local computer
store. It’s OK. You won’t catch anything.
We ﬁrst used Boot Camp on a pair of
Intel-based iMacs to partition the hard
drives (which you can do dynamically
without affecting your Mac installation
or user ﬁles) and to create a CD
containing the Mac hardware drivers.
We were then able to install XP in about
45 minutes. After the XP installation
was complete, we then installed the
Mac drivers from the CD. After that, we
were able to choose which OS to use at
startup (switching operating systems
requires restarting your Mac).

Worlds are colliding!

We did experience an unresponsive
OS-selection screen, which worked after
restarting the Mac a second time. Also,
when we tried to use the iMac’s built-in
iSight camera by selecting Start > All
Programs > Accessories > Scanner And
Camera Wizard, we consistently crashed
Windows. These minor problems
aside, XP felt quite snappy on our Mac
hardware; windows opened and closed
briskly, apps launched without any
hitches, and the victory cascade in
Solitaire ﬂowed like water over Niagara
Falls. Our 2GHz iMac running XP even
posted an impressive 42.7 frames per
second in Doom 3, compared to 41 fps
when using the Intel-native Mac OS X
version. But when converting 25 AIFF
ﬁles to MP3s in iTunes, Mac OS X was
17 percent faster than Windows XP.
You can’t see your Mac partition
when you’re running XP, but you can see
your XP partition when you’re running
Mac OS X. However, if you format your
XP partition using Windows’ NTFS
ﬁle system, the XP partition is readonly when you’re running Mac OS X; a
partition formatted using the FAT32 ﬁle
system is read/write. (For explanations
of these ﬁle systems and more Windows
gobbledygook, see “Windows XP on
Your Mac,” p34.)
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Just for giggles, we also tried to
upgrade our XP installation to a beta of
the next iteration of Windows (known
as Vista) using an XP-to-Vista upgrade
installer, but that installation failed—
and trust us, there are few things as
unsettling as seeing a beautiful new
iMac emblazoned with the dreaded
Windows Blue Screen of Death. Well,
the Vista upgrade is a beta, after all.
Why? “Boot Camp makes the Mac
more appealing to those willing to
switch,” said an Apple spokesperson
we interviewed, who also deﬁned the
two groups of customers Apple hopes
to reach. The ﬁrst includes Windows
users who are intrigued by the Mac,
but still need to use some applications
that currently run only in Windows;
Boot Camp grants them access to those
apps. The second group includes people
who want to switch but fear leaving
some feature or app behind, and want
some sort of “safety net.” As for Apple
possibly selling Macs with Windows
preinstalled, the Apple rep we spoke
to reiterated what Apple Senior Vice
President Phil Schiller said in a press

release: “Apple has no desire or plan to
sell or support Windows.”
Boot Camp is actually a sneak peek
at a feature scheduled for Mac OS
10.5 (Leopard), expected at the end of
this year. According to Apple, the beta
period for Boot Camp runs through
September 2007. This late date for
the end of the beta period doesn’t
necessarily mean that Leopard won’t
ship for a year and a half; we project
that Leopard will ship well before that
far-off date, and that Apple will urge
users to upgrade to Leopard to continue
using Boot Camp.
Boot Camp could be a sign of things
to come. Maximum PC Senior Editor and
übergeek Gordon Mah Ung thinks that
the whole computer landscape could
drastically change in the next 18 months.
He believes it’s possible that Boot Camp
is the precursor to Apple releasing
Mac OS X for PCs in the near future.
“(Windows) Vista has been delayed,
and the beta versions are unimpressive,”
says Mah Ung. “If Apple released OS X for
the PC, that could change everything.”
We agree.—Roman Loyola

GAME DEVELOPERS WEIGH IN

While game developers are expressing everything from glee to caution about the
effects of Boot Camp on their business, they all agree the winners are Mac gamers.
“I take this as one of the best announcements for Mac game players ever!” says
Peter Tamte, president of Destineer Studios in Minneapolis. “They can play any
game from the Windows or Mac library, and they get to do it on their Macintosh.”
Glenda Adams, director of development for Aspyr, however, takes a “not so
fast” attitude. “We’re a little wary of how many users will pick up the PC version
of a game rather than the Mac version. If we’re doing a new PC game, we’d like to
hear from Apple as to why we should do a Mac-speciﬁc game.”
Ian Smith, president of New York–based Freeverse, echoes, “It may have a
chilling effect [for the games that come out ﬁrst on the PC]. For games that are fullscreen, the OS doesn’t really matter. But we really just don’t know.” But for casual
games such as the ones Freeverse publishes, “It will have much less of an effect.
People will still do email on the side and want their Mac OS. It shouldn’t affect our
core business.”
Mike Jaret, marketing maven at Go
Grand Theft Auto
on your Mac!
Postal, which publishes its games in
several formats at once, thinks that “it
can only help broaden our audience,” a
position Destineer’s Tamte agrees with.
As for the Boot Camp experience, Jaret
says, “[Go Postal’s games] didn’t run at
all; I think we have some major issues with
dual-core processors, but I’m not positive.
But Half-Life 2 Counter-Strike: Source and
Battleﬁeld 2 worked great!”—Anita Malnig

NEW STUFF

NEW STUFF

4READY AND STEADY
gorillapod

$24.95
www.joby.com
Available: Now

Stop worrying
about the
shakes.

With its ﬂexible
legs, gorillapod
can be used as a standard tripod or
wrapped around a pole, tree branch,
or any other stationary object to take
steady pictures.

4LEADING THE

COLOR BLIND
eyePilot
$34
www.colorhelper.com
Available: Now

This app helps
folks with colorvision problems
by layering
an interactive
ﬂoating window
Is it red? Is it green?
over any window
Now you’ll know.
on your Mac’s
screen. You can then use one of
several different tools to help you
identify a color in the window.

4RUBBER

PROTECTION
Velocity
Pro Laptop
Backpack Blue
$79.99
www.slappa.com
Available: Now

Slappa uses
“scuba-prene”
and thick
molded rubber
on this backpack.
You can use either
Is it just us, or
a messenger-bag
does this look
strap or the standard
like Spiderdouble shoulder
Man’s mask?
straps. Inside the
main section, a padded inner
laptop sleeve protects your ’Book.

June 2006
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Geneva Lab’s Model L ($674, www
.genevalab.com) contains a pair of
1-inch tweeters and two 5.25-inch
woofers. In addition to iPod support,
the Model L offers an FM radio and
built-in slot-loading CD player. You can
also use the line-in connectors for your
DVD player, TV, or Mac. The cabinet is
made of piano-lacquered wood and is
available in white, black, and red.

12
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IMAGE COURTESY OF THINK OUTSIDE
IMAGE COURTESY OF GENEVA

Sexy
SpeakersB

iPOD ACCESSORIES

Think Outside’s Boomtube H2O1 ($250, www.thinkoutside.com) is a
portable speaker system that features four 2-inch drivers, an anodized
aluminum case, and a rechargeable LiIon battery. Three-foot cables allow
better stereo separation than most portable systems. You connect your
iPod or any other audio source to the Boomtube’s audio-in connector.

What’sNew

Sexy Stuff We Can’t Wait to Get Our Mitts On

Booming TubeC

• Nyko’s Speaker
Dock 2 ($99.99,
www.nyko.com)
is a speaker stand
measuring 5
inches around and
6.5 inches tall. It
features two builtin speakers and is
powered by its AC
adapter or four AA
batteries.
• SiK’s lix ($19.99
to $24.99, www
.sik.com) is a thin
polycarbonate iPod
case available in
several designs,
including clear.
• MTX Audio’s
iThunder ($199.95,
www.mtx.com) is a
boom-box speaker
system for the
iPod with a pair of
four-inch drivers.
It’s powered by
either AC or eight
C batteries.
• Intuitive Devices’
Blinkit ($29.95,
www.blinkitnow
.com) is a light that
acts as a ﬂashlight
Speaker Dock 2:
or blinking safety
hopping on the
light for joggers; it
iPod-speaker
ﬁts into an iPod’s
bandwagon.
dock connector.
• Xitel’s HiFi-Link for iPod nano ($69.95,
www.xitel.com) is a docking station
designed to connect your iPod nano to
home stereo equipment. The HiFi-Link
also charges the nano and comes with
a remote control.
• Keyspan’s TuneView Remote and
TuneView Dock ($179, www.keyspan
.com) lets you remotely control your
iPod. The Remote has an LCD that lets
you see what’s in your iPod’s library.
• Jabra’s A125s Bluetooth Adapter
for iPod (price TBD, www.jabra.com)
attaches to the iPod’s dock and
transmits via Bluetooth to compatible
Jabra headsets.
• DLO’s HomeDock Deluxe ($149.99,
www.dlo.com) is an iPod dock that
connects to your TV. The dock lets you
control and select your iPod’s music
on the TV screen.—Michelle Victoria

>>>>>>>>

DROOLWORTHY

adsbygoogle.com
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SHAREWARE PICK OF THE MONTH
iSquint

www.isquint.org freeware

I

t’s irritating that even if you pay good money to register QuickTime Pro, you have zero control over iPod videoexport options in QuickTime Player. iSquint converts movies to video-capable-iPod formats and gives you control
over size and quality; it can also batch-process multiple movies.—Andrew Tokuda

2 Your iPod displays movies
at 320 by 240 resolution (the
resolution of the videos you buy
at the iTunes Music Store), but if
you connect your iPod to a TV, you
can use a higher resolution—400
pixels wide by 300 pixels high,
for example.

RELIVE
HISTORY
How much do you
actually know about
Apple’s 30-year
history? Here are a
few Web sites you
can use to refresh
your memory (or gain
some knowledge) about
the Cupertino company.
• apple-history.com (www
.apple-history.com) provides
Apple’s 30-year
a historical synopsis of Apple.
anniversary didn’t come
Even better? Its archive of
without growing pains—
product speciﬁcation sheets
such as the eMate.
dating back to 1976.
• Folklore (www.folklore.org) contains anecdotes from Mac
pioneer Andy Hertzfeld about the development of the
original Mac.
• Mactracker (www.mactracker.ca) is a handy free utility
that provides easy access to info about every Mac (and
Mac clone) ever made.
• Making the Macintosh (http://library.stanford.edu/mac)
serves up Mac history and interviews with Mac luminaries,
including Susan Kare and Jef Raskin.
• The Different District (www
.differentdistrict.com/movies) houses
ON THE
DISC
a collection of over 250 Apple-related
videos, including ads, parodies, and
Mactracker,
Mactracker for iPod
more.—RL
14
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3 iSquint encodes in MPEG-4
video by default. To get the best
possible quality, enter a Video
Bitrate of 2,500 kilobits per
second and a Framerate of 30
frames per second.

4 If you want to use these
settings for multiple videos, just
drag them into the queue, and
then click Start. When iSqueeze
is done, you’ll have great-quality
videos that you can load onto your
video-capable iPod.

FRANCE PUSHES
TO DUMP DRM
France’s Assemblée nationale, the lower house of France’s
legislature, passed a bill forcing companies such as Apple,
Microsoft, and
Sony that sell music
protected by Digital
Rights Management
to open up their
DRM technology
so that any digital
music player can
play music bought
from any online
store, such as the
iTunes Music Store.
In response, Apple
spokeswoman
Natalie Kerris told
Reuters, “The French
implementation of
the European Union
Copyright Directive
will result in statesponsored piracy.”
The bill goes before
le Sénat (the Senate)
in May.—RL
Will iPods soon be
passé in France?

PHOTOS COURTESY OF APPLE AND THE MDA

Drag your movie to the
empty area in iSquint. Then
click the Advanced button
to open the Advanced
Settings drawer.

16
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iPOD CASE
OF THE MONTH

Bug of the Month

>>>>>>>>>>>>>>>>>>>>>>>>>>>>

T

W H AT T O D O W I T H YO U R P R E V I O U S S Y S T E M

inpod’s cases are made of—you
guessed it—tin, and feature the
artwork of Kurt Ketchum, who’s
done work for such diverse clients
as Apple, Def Jam, and Pepsi. The
neoprene-lined L’Orange Lune
($16.95, www.thetinpod.com) and
Change Attitude ($16.95) both have
holes for your earbuds. Yeah, we
know you can’t see your iPod screen
and access your Click Wheel through
the cover, but is it really that hard
to ﬂip open a lid? Sacriﬁce a little
for art’s sake; speaking of which,
Tinpod donates $1 from each case
sale to the Cityarts program in New
York, NY.—Michelle Victoria

SEGWAY HT POLO

A

lthough Apple cofounder Steve Wozniak no longer has an everyday role
with the Cupertino company, he does have plenty on his plate, including his
involvement in Segway HT Polo. Woz takes his Segway Polo seriously—not only is
he a member of the Silicon Valley Aftershocks, but the prize of the World Segway
HT Polo Games is called the Woz Challenge Cup. In the inaugural match of the Polo
Games, held in New Zealand, the Aftershocks battled the New Zealand Pole Blacks
to a two-to-two tie. Next year’s Polo Games will be played in California.
If you’re lucky (and loaded) enough to own a Segway HT, you might be able to
ﬁnd pick-up Segway polo games in your area. For example, the Bay Area Segway
Enthusiast Group (www.bayareaseg.com) holds matches every ﬁrst and third
Sunday of the month, weather permitting. Visit the Segway Enthusiasts Group
America (www.segamerica.com) or SegwayHTPolo.com for more information.
—Roman Loyola
16
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PHOTOGRAPH BY LIZ QUILTY

The new game of the rich.

Can hold curiously strong
breath mints, as well.
SUBMIT YOUR CASE Whether your iPod case is a
custom-made one-off or mass produced, you can submit
it for Case-of-the-Month consideration—just send it to
iPod Case of the Month, MacAddict, 4000 Shoreline St.
Suite 400, South San Francisco, CA 94080. Please note
that we cannot return cases.

AU REVOIR, AVIE

S

teve Jobs gets a
lot of credit for
bringing Apple back
from near death, but he
couldn’t have done it
without Avadis “Avie”
What’s next
Tevanian, who left his
for brainy
post as Apple’s chief
Tevanian?
software technology
ofﬁcer this March to “pursue other
interests.” In 1997, when Apple bought
NeXT, Tevanian joined Apple and led the
Mac OS X development efforts.—MV

PHOTO COURTESY OF APPLE

T

his month’s Bug of the Month isn’t a bug, per se, but rather some advice that
will help you deal with future bugs that could pop up after you reinstall Mac
OS X. During installation, you have the option of performing an Archive And Install
operation (click the Options button at the Select A Destination screen). Archive
And Install moves your existing Mac OS X System ﬁles to a Previous System folder
before it installs a fresh OS.
When the installation is ﬁnished, a Previous Systems folder appears at the root
level of your hard drive, which is required for reverting to an earlier version of OS
X or for dealing with other issues should your new installation prove problematic.
Inside the Previous Systems folder are Library ﬁles, user settings, and other
system-level folders and ﬁles that your previous Mac OS X installation used. It
also includes Mac OS X–installed apps, such as Address Book and Mail. Here’s
what you should do with your Previous Systems folder:
BACKTRACK Keep this folder around for a week or two after performing your
Archive And Install, in case you need to retrieve any preference ﬁles. Note that
you can’t start up using the system ﬁles in the Previous Systems folder.
DELETE DUPLICATE APPS Immediately delete all apps contained in the Previous
Systems folder, or you may experience problems with new versions of the same
apps stored in the default Applications directory. All you have to do is delete the
Applications folder within Previous Systems. Also, delete the duplicate Applications
folder before applying the most recent Mac OS X combo updater from Apple’s Mac
OS X Downloads Web site (www.apple.com/downloads/macosx/apple).

NEW! Wacom Graphire4
Have fun with your digital photos

Enhance photos with pen control
Quickly and easily edit your digital photos using the
control of the Graphire pen and your included copy
of Adobe® Photoshop® Elements 3. Selectively apply
high-quality photographic enhancements using the
included nik Color Efex Pro™ 2 GE filter collection.

Draw and paint
Create original artwork with the natural feel of your
Graphire pen and the amazing capabilities of the
®
™
included copy of Corel Painter Essentials 2.

Jot notes, mark-up, and sign
Use your Graphire pen on a Mac to enjoy all the
digital-inking capabilities of Apple® Inkwell®.

Patented pressure-sensitive pen
• 512 levels of pressure sensitivity for natural
brush control
• Patented cordless, battery-free technology for a
natural feel and superior performance

Cordless, battery-free mouse

From $99

• Patented cordless, battery-free, ball-free, and
optics-free mouse with three programmable
buttons and a scroll wheel
• Alternating between the pen and the mouse
reduces repetitive motion

Valuable software included
Includes Adobe Photoshop Elements 3, Corel Painter
Essentials 2 for creating natural media art, nik
Color Efex Pro 2 GE for selectively applying photo
enhancements, and more.

Have fun with your photos!
AVAILABLE AT:

Best Buy, CompUSA, and WacomDirect.com

Intuos 3

Cintiq

For the serious photographer!
Intuos starts at $219

Work directly on screen!
Cintiq 21UX – $2499

®

AVAILABLE AT:

CompUSA, CDW.com, and WacomDirect.com

®

AVAILABLE AT:

Visit
www.MacPhotoFun.com

Call
1.800.922.1247

B&H, CoolGraphicStuff.com, and WacomDirect.com

Watch for the Penabled logo to ensure you’re getting the natural feel and superior performance of Wacom’s patented cordless and battery-free pen technology.
©2005 Wacom Technology Corporation. Wacom, Graphire, Intuos, Cintiq, and Penabled are trademarks of Wacom Company Ltd. All rights reserved.
All other trademarks are property of their respective owners. All prices are U.S. estimated street prices.
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iPod:

Beyond
theBasics

Here’s how to keep your precious
’Pod in perfect shape—plus a few
things you can do with it besides
playing music.
18
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e know you love your iPod. But as in any
relationship, there’s a risk of taking your
beloved for granted—that is, until the day your

’Pod doesn’t behave as you expect. Maybe it won’t sync.
Maybe its screen stays mysteriously dark. Or maybe it just
runs out of juice faster than it used to. Don’t despair—just
follow these tips to keep you and your ’Pod on the best of
terms, and entertain it by teaching it some new tricks.
By Jake Widman and Ryan Arter

Photography by Mark Madeo
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My iPod Won’t…

Got ’Pod problems? Here are
the first things you should do
if your iPod won’t…

…Charge:

1. Try a different cable or port.
2. See if your iPod will charge from another computer or from
a wall socket with its power adapter.
3. Replace the battery.

…Sync:

1. Try a different cable or port.
2. Use the iPod Updater (www.apple.com/ipod/download) to
perform a Full Restore. Remember, though, this’ll wipe out
everything on your iPod, so make sure you have backup
copies of all your music, videos, photos, and other goodies
before proceeding.

If the steps outlined above don’t do the trick,

you can check the condition of your ’Pod’s hard disk with
the iPod’s built-in diagnostic routines. First, reset your
iPod (see “iPodigree,” p21). For third-generation (3G)
iPods or earlier, as soon as you see the Apple logo, press
and hold Forward, Back (aka Rewind), and Select; for the
nano, mini, fourth-generation (4G), and
ﬁfth-generation (5G) iPods, hold
down Back and Select. Presto!
You’re now deep inside the
Did You
arcane world of Diagnostic
Know...?
Mode. On a 5G iPod, you
Cure Drive Problems
can simply perform an
When your iPod is mounted in Disk mode,
you can use Mac disk-diagnostic utilities to
Auto Test by pushing the
cure its ills. We’ve had good results running
Back button. On other
Apple’s Disk Utility (/Applications/Utilities)
and Alsoft’s DiskWarrior ($79.95, www
models, you’ll see a
.alsoft.com). Apple, however, recommends
list of tests that you can
using only its iPod Updater to fully
restore the ’Pod, which reformats
navigate through with the
the drive and cleans up the iPod
Forward
and Back buttons
database.
(the clickwheel won’t work
here). On 3G iPods or earlier,
navigate down to the item named
O. HDD Scan, and press Select. On other
models, navigate down to IO, press Select, navigate to
HardDrive, press Select, and choose HDScan. These tests
take more than a few minutes, but they’ll tell you if your
hard drive is kaput. When you’re ﬁnished testing, reset the
iPod again to get out of Diagnostic Mode. (You can ﬁnd
more information about the cryptic world of Diagnostic
Mode at www.methodshop.com/mp3/ipodsupport/
diagnosticmode.)
If your drive fails the test and none of the other steps
outlined above helped, it’s time to send your precious ’Pod
off for servicing. You can arrange for service through Apple’s
Web site (www.apple.com/support/ipod/service) or send
your iPod off for diagnosis and repair at an independent

20
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…Start Up:

1. If your iPod doesn’t have any power at all, and charging
doesn’t help, you probably need a new battery.
2. If your iPod also doesn’t work when it’s docked or plugged
in, it probably needs professional servicing.

…Shut Itself Off:

1. Perform a hard reset (for how to reset your model iPod, see
“iPodigree,” p21).
2. Update the iPod software using the iPod Updater as
mentioned in “...Sync,” or perform a Full Restore.
3. If that doesn’t work, your poor ’Pod may have a logic-board
problem, which will require professional servicing.

…Display Anything but a Folder
Icon with an Exclamation Point:
1. Charge the battery.
2. Do a hard reset.
3. Perform a Full Restore.

service center such as iPodResQ (www.ipodresq.com),
TechRestore (http://techrestore.com), or iPodMods (www
.ipodmods.com). Oh, and in the interests of purity of heart and
full disclosure, we gotta tell you that the president and owner of
iPodResQ, Ryan Arter, contributed to this article.

Editors’ Picks

Jake’s Fave Gear
eVo

iSkin, $14.99 to $34.99,
www.iskin.com
iSkin’s silicone cases ﬁt perfectly
(unlike others I’ve tried, whose
clickwheel cutouts I could never
quite align). These give you a good
grip on your ’Pod and protect it
against bumps; they also come
with screen and wheel protectors.

FMCup

Macally, $59.99,
www.macally.com
I do most of my ’Podding
in the car, and this is my
favorite FM transmitter.
It’s easy to change
frequencies, and it has
presets for the ones that
work best. It also cuts
through interfering FM
frequencies better than
any others I’ve tried.
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Solutions that make sense.

Sleevz™
for iPod, 3G, 4G, 5G, Mini and Nano

Save 10% on:
Sleevz, Ice Creme and Cables
with Promo Code MA66H

• Optex Super 80™ sleeve case for iPod
• The original control-through sleeve
• Transparent, non-abrasive screen protection

Ice Creme® M
for iPod, 3G, 4G, 5G, Mini* and Nano
• Removes surface abrasion and scratches*
• For iPod, iBook or any acrylic or bright
metal surface

RetractCable™
iPod dock connector
• High-speed USB 2.0 or 6-pin FireWire
• Extended cable length: 76cm/30in
• Perfect mate for Acclaro iPod cases

*iPod Mini - Screen only

www.radtech.com
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Maximize Your
’Pod Power
Apple claims that the battery in today’s top-of-the-line 60GB
iPod provides enough juice to play 20 hours of music, and
that it will last through hundreds of charging cycles. Earlier
models weren’t as juicy, but even the first-generation ’Pod
was rated at 10 hours and 500 cycles. Sooner or later,
however, an iPod’s battery will wear out. Here are some steps
you can take to make sure that unfortunate inevitability
occurs later rather than sooner.
PUT IT THROUGH A CHARGE CYCLE ONCE PER MONTH Even if
you only listen to your iPod when it’s docked, once a month
you should let it play overnight unattended until it drains its
battery, and then charge it up again the next day. Like all of
us, LiIon batteries beneﬁt from regular exercise.
TAKE IT OUT OF ITS CASE BEFORE RECHARGING There’s no
fan in your iPod—its stainless-steel back serves as its heat
sink—so insulating the back with a case blocks your ’Pod’s
ability to exchange heat with the outside air. Even though the
hard disk isn’t spinning during a recharge, your ’Pod could
get uncomfortably hot inside—and batteries don’t like heat.
MAKE SURE YOU HAVE THE LATEST iPOD SOFTWARE
Sometimes software updates include battery-management
improvements.
KEEP YOUR ’POD COMFY Though your iPod’s operating
temperature range is 32 to 95 degrees Fahrenheit (0
to 35 degrees Celsius), its battery is happiest at room
temperature. Don’t leave your iPod in direct sunlight or
in your car parked in the sun. If it’s left in the cold (the
acceptable storage temperature range is –4 to 113 degrees
F, –20 to 45 degrees C), let it come back to room temperature
before waking it up—and if it won’t wake from sleep even
after it’s warm, try resetting it.
USE THE HOLD SWITCH Yes, we know you’re only dropping
your ’Pod in your purse while you go to the store. Three hours
later, you’ll ﬁnd that your checkbook pressed its buttons,
and your iPod’s been playing the whole time. Just slide the
Hold switch to let what’s paused stay paused.
JUST LISTEN When you jump from one track to another with
the Previous or Next buttons, you force the iPod to spin
up the hard drive each time, putting a serious hit on your
battery power.
TURN OFF BACKLIGHTING If you don’t need backlighting,
don’t make your battery pay for it. Go to the Settings menu
and choose Backlight Timer > Off.
TURN OFF THE EQUALIZER If your songs sound reasonably
acceptable without iPod EQ enhancements, turn ’em off: Go
to the Settings menu and choose EQ > Off. EQ settings aren’t
encoded in your tunes, so your iPod has to use its processor
to apply them, and that sucks power. If you want to hear
the EQ settings you’ve chosen in iTunes, you gotta set your
iPod’s EQ to Flat.
PLAY COMPRESSED SONGS The iPod plays songs from
a memory cache and only spins up its hard drive when
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Did You
Know…?

it needs to reﬁll that cache.
Hide Your Tunes
This process works best
You can hide everything on your iPod
except for the contents of the Notes folder
when songs average less
by putting your ’Pod in Notes Only mode.
than 9MB in size. Even if
Just create a text file with the line <meta
name=”NotesOnly” content=”true”>
you prefer uncompressed
(make sure to include the brackets), and
song ﬁles on your Mac,
save it with the name Preferences. Copy
that file into an iPod’s Notes folder, and
make compressed versions
users of that ’Pod will be prevented
for your iPod (which will
from seeing anything but the
contents of its Notes folder.
also let you ﬁt more songs, of
course). It’s also a good idea to
break exceptionally long tracks—
such as that hour-long, sinsemilla-inspired
Grateful Dead jam you downloaded—into multiple
smaller ﬁles.
BUY A BETTER BATTERY If you ﬁnd that you’re regularly
pushing the limits of your iPod’s playing time, you might
consider putting in a higher-capacity battery, even if yours isn’t
worn out yet. iPod upgraders such as iPodResQ (www.ipodresq
.com), Other World Computing (www.macsales.com), and
TechRestore (www.techrestore.com) will sell you batteries with
a higher milliamp-hour rating than the stock Apple battery for
30 bucks or so, as long as you have the guts to install a new
battery yourself. If you’re light on guts, have no fear—the same
companies will put the battery in your ’Pod for only
a few dollars more.

Editors’ Picks

Niko’s Fave Gear
invisibleShield

ShieldZone, $9.95 to $24.95, www.shieldzone.com
I just blew a full week descratching my iPod and carefully
cutting and ﬁtting my own clear plastic ﬁlm covering (see
“Prep Your iPod for
Armageddon,” p66).
If time is money, I’d
have saved a bundle
by dropping $20 on a
proper invisibleShield in
the ﬁrst place.

iPod USB Power Adapter

Sonnet Technologies, $19.95, www.sonnettech.com
Perfect for traveling light, sans Mac.
At roughly half the size of Apple’s
iPod power brick, the included
dock-connector cable makes
it effectively half the price
as well.

Boot Up with
an Old iPod

So, you have a ’Pod you don’t use. You could give it away—or you
could turn it into an emergency bootable hard disk with disk-repair
utilities on it. But before you start, note that an iPod’s hard drive
isn’t meant for full-time operation—it’s not designed to spin as
much as a system disk does and will generate a lot of nasty heat.
Also, this trick is intended for FireWire-equipped iPods (mini
excluded), because you can’t install Mac OS X directly onto a
USB disk without using Carbon Copy Cloner (donationware,
www.bombich.com) or other installer trickery—which
coincidentally neuters an iPod’s musical abilities. For the record,
our Intel-powered iMac booted ﬁne (if slowly) off of a USB-only
ﬁfth-generation iPod onto which we had cloned Mac OS 10.4.5.
To turn your FireWire iPod into a bootable drive, connect
your iPod to your Mac, put a Mac OS X install disc in your Mac’s
optical drive, and start the installation process. When you get
to the Select A Destination screen, select the iPod and proceed
with the installation. As long as you don’t pick one of the eraseand-install options behind the Options button, your iPod will
emerge as a bootable hard drive that still functions perfectly
well as an iPod.

Did You
Know…?

Personalize Your ’Pod

You can change your iPod’s main menu
to your liking. Go into Settings > Main
Menu and scroll through the choices,
turning On or Off the items you want to
see or not see—you can even turn any
’Pod into an iPod shuffle by turning off
everything except Shuffle Songs. You
can’t get rid of the Settings menu item,
however, so you can still get all your
choices back.

Editors’ Picks

Rik’s Fave Gear
iLingo Asia Pack 2.0

Talking Panda, $39.95, www.talkingpanda.com
Want to learn to speak Cantonese
or Mandarin Chinese, Japanese, or
Korean? Just want a talking phrase
book to carry on your travels? Your
iPod can help—if it’s equipped with
Talking Panda’s iLingo Asia Pack.
If you’re visiting Europe, load the
$49.95 iLingo Euro Pack 2.0, which
will assist you in France, Germany,
Italy, Spain, Portugal, and Russia.

iTTUSB

Ion Audio, $139.95, www.ionaudio.com
No, it’s not an iPod accessory per se, but this
USB turntable can help rip your vinyl
collection into MP3s so you can
pop ’em onto your ’Pod. Audacity
recording software is included,
along with a trial version of Bias’s
SoundSoap 2 for cleaning up all
your albums’ pops and scratches.
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iPod:Beyond
theBasics

How to Speak
Shufﬂese

▲

The iPod shuffle’s communication abilities aren’t up to
those of its siblings: It doesn’t have a screen, so it can’t
show you what’s playing or let you scroll to the song you
want. But it’s not entirely mute—it can tell you a lot, if only
you know how to listen—well, watch, actually.
And while the shufﬂe is all about random, sometimes you
want that warm, cozy feeling of being in control:
TO SKIP TO THE BEGINNING OF YOUR
PLAYLIST Put your shufﬂe in
Repeat mode, and press the
Did You
Pause/Play button three times.
Know…?
TO SKIP TO THE END OF YOUR
Get Directions
You can view transit info on your iPod. Go
PLAYLIST Use the previous
to www.isubwaymaps.com and download
trick to get to the beginning
maps for cities from Berlin to Washington,
DC. If you live, as we do, in the San
of your playlist, and then
Francisco Bay Area, go to www.bart
press the Back button.
.gov/stations/quickplanner/ipod.asp and
download the Official BART QuickPlanner
TO FIND A PARTICULAR SONG
for Apple iPod. If you live elsewhere,
First make sure to sort your
your local transit folks might be just
playlist in iTunes by song before
as tech savvy. Ask ’em.
sending it to your shufﬂe. Now,

iPOD SHUFFLE’S MAIN
STATUS LIGHT STATE

WHAT IT MEANS

Solid orange

Charging, OK to disconnect

Blinking orange

Mounted, do not disconnect

Solid green

Fully charged, OK to disconnect

Blinking green

Paused (light will turn off after
one minute)

Solid green

Play (light will turn off after two
seconds)

Solid orange when you press a button

Hold is on (to turn it off, hold the Play/
Pause button for three seconds )

Solid green when you press a button

Normal operation of that button
(light stays on as long as you press
the button)

Blinking green and orange

You’re trying to play a song, but the
shuffle is empty

iPOD SHUFFLE’S BATTERY
STATUS LIGHT STATE

WHAT IT MEANS

Green

Good charge

Amber

Low charge

Red

Very low charge

Off

No charge

iPod
Pileup!
We found this pile o’ rejected

’Pods in a Cupertino dumpster.
Can you figure out
what’s wrong with
each model?

4

1

3

5

6

June 2006

4. The fifth-generation iPod has no remote connector.
5. The iPod nano’s dock connector is offset to the left,
not as close to the center.
6. The iPod shuffle has no display. Yeah, that one was
a gimme.
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1. The first-generation iPod didn’t have a dock
connector.
2. The iPod mini never came in black.
3. The fourth-generation iPod’s clickwheel was gray,
not white.
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Home
Movie
Magic

To see the
techniques in
this article in
action, watch
our finished
home movie at
www.macaddict
.com/sfvideo.

With iMovie HD, you can create
a vacation video that your friends
will actually want to watch.
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ILLUSTRATIONS BY KEN BOUSQUET

By Andrew Tokuda

B

ack in the golden-olden days, there existed a device
that in-laws would pull out of the closet during family
get-togethers: the dreaded slide carousel. With this
insidious machine, family members could inflict hours
of torture as they forced their victims to sit through droningly
narrated scenes of their latest trip to Yellowstone, Niagara
Falls, or Branson, MO. Other families did similar mind-numbing
damage with unedited, shaky Super 8 movies.

28

June 2006

Fortunately for us (and our guests), Macs now offer you the
power to take moving images, cut out the boring parts, and
string the good bits together. We’ll tell you what accessories
to glom onto before you start shooting (see “Successorize for
Shooting,” p31) and show you how to use iMovie HD to turn your
raw vacation footage (even if it’s just as unexciting as your inlaws’ slides) into a breathtaking piece worthy of an Emmy—or
at least something that’s fun to watch.

GRAB YOUR CLIPS
We started with footage shot during a gray, rainy March afternoon in San Francisco.
When we got back to our warm, dry living room, we just connected our DV camcorder
to our Mac and used iMovie HD to import the video, letting it automatically start
a new clip at each scene break (the default setting). When you do the same with
your footage, you’ll end up with the Clips pane full of scenes that you can drag to
the Movie Timeline as you build your movie. (You can also import the video directly
into the Timeline by changing iMovie’s Preferences > Import setting.)
Step one: Fill the Clips pane with
the source material for your movie.

OPEN IMPRESSIVELY

Themes give you world-class graphics that’ll get “oohs” and “ahhs” from your audience.

One of iMovie’s coolest features will make
you look like a video god or goddess before
you even edit your first clip—and that feature
is Themes. Themes are templates filled with
professionally made moving graphics that
break the old movie-title mold and add a big
dose of “Wow!” To put them to use, click the
Themes button in the lower-right corner of
the main iMovie window. There you’ll find
a pop-up menu containing various Themes
such as Travel and Road Trip. Since this is
a vacation video, choose the Travel Theme.
Click the first Theme Element (Open) to craft
your movie’s opening title screen. A good
intro will rope in your audience and let them
know they’re about to see something special.

Hey, we just typed that title. Could it really
be this easy?

Drag and drop your clips to personalize
the Theme.

When you see a slow-moving red bar, it’s
time to take a break.

1. Preview and Title

2. Drop Zones

3. Render Time

If you don’t see an animation in the main
iMovie window when you click the Open
Theme Element, click the Show Preview
button under the Theme Elements
thumbnails on the right. Personalize
the Theme by adding your footage and
typing your title in the Title 1 field (under
the Show Preview button). Make sure it
shows up in the moving preview before
you proceed.

You should also see a floating, gray,
semi-transparent palette titled Drop
Zones—if not, click the Show Drop
Zones button next to the Show Preview
button. Now click the Clips button.
Drag various scenes from the Clips
pane to the numbered Drop Zones,
and watch them magically appear
in the preview. Your movie’s intro is
already looking mahvelous, dahling.

When you’re satisfied with how the
preview looks, you’ll need to render
it so it’ll play back in real time. Click
the Themes button, and then click the
Apply button to finalize your opening
animation and put it in the Timeline. The
rendering part can take a while—luckily,
you can continue to work while iMovie
renders in the background. Or do as the
pros do: Take a well-deserved break.
June 2006
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ADD FREE FOOTAGE
As exciting as The City—as immodest San Francisco folks
call it—may have looked while we were there, to someone
watching it onscreen, it’s just the site of yet another
vacation video. But found footage—video you didn’t shoot
yourself—can add some visual interest and texture to any
movie. Thanks to the Internet Archive (www.archive.org),
we found nearly 15 minutes of a streetcar ride down San
Francisco’s main drag, Market Street, shot in 1905. As luck
would have it, we happened to drive down Market Street
ourselves. Can you see where this is going?

The Internet Archive has lots of free footage to spice up any video.
You gotta love public-domain goods.

1. Convert Video
The best version of the old movie we found was a 320-by240-pixel MPEG-2 multiplexed video file—a format that
doesn’t work with iMovie HD, which only uses DV and HDV.
Since our own video was DV, we needed to convert the 1905
footage to match. The easiest way to perform this kind of
conversion is with QuickTime 7 Pro ($29.99, www.apple
.com): Open the file in QuickTime Player and choose File >
Export. From the list of options, choose Movie To DV Stream.
This process may take a while depending on the length
of the video, so let it work in the background, or use the
conversion as an excuse to take another break.
The resulting file will have a .dv extension; just
Turn found footage into a DV
drag it into an open slot in the Clips pane.
Stream to use it in iMovie HD.

2. Speeding Down Market Street
Now back to our nifty idea—opening our movie with a transition from
the 1905 footage to our own Market Street video. First, we clicked
the movie in the Clips pane to view it in the Clip Viewer, then found
our favorite 60 seconds, and placed crop markers on either end of
the sequence. Choosing Edit > Crop trimmed the movie to those 60
seconds, which we dragged from the Clip Viewer to the Timeline. To
speed up the streetcar to match the speed of our car, we clicked the
clip in the Timeline, then clicked on the Editing button, and chose
Video FX > Fast/Slow/Reverse. Dragging the Speed all the way to Faster
and clicking Apply made us move at present-day speeds—and reduced
the clip to about 15 seconds, which was fine for our purposes.

Surprisingly,
traffic was more
hectic back in 1905
than it is today—
especially once we
sped up our slowmoving footage.

3. A Hundred Years in Seven Seconds
Next, we cropped out about 30 seconds of our modern-day Market Street footage and
dragged it into the Timeline, to the right of the 1905 sequence. To create a transition,
we selected both
clips by Shiftclicking them;
we then selected
Editing > Transitions
> Cross Dissolve. To
make the transition
gradual and smooth,
we set the Speed
(duration, actually)
to 7 seconds. What
a cool opening!
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The Cross Dissolve effect gave us a
nice, slow transition from 1905 to 2006.

HOME MOVIE MAGIC

SAVOR STILLS
You can import photos into
iMovie, so why not add a
slide show of your vacation
still photos at the close of
your video? Call it an homage
to grandma and grandpa’s
pre-video era. Begin by
clicking the Media button
at the lower right of the
main iMovie window. Select
Photos to gain access to your
iPhoto Library. CommandYour iPhoto pictures appear in the Media pane. From click the photos you want,
there, you can drag and drop multiple photos into the and drag them into the
Timeline.
Timeline to use them in your slide show.

1. Custom Burns

TRIPOD Tripods both stabilize
your camera and allow
smoother panning than is
possible with just your hand.
For your vacation videos,
they also let you join in on
the fun—with a tripod, you can
press the record button on your
camera and jump into the shot. Now you’ll
have proof that, indeed, you were there.
BIG BATTERY All camcorders
come with a battery. A small
one. Unless you look in
the included accessories
catalog, you may not know
that batteries can come in
different sizes. Here’s a simple
tip: Big batteries mean longer
shooting time. A small battery might last a
couple of hours, but a big one can last six
or more. Buy one of the largest batteries
you can for your camcorder, and use that
as your main battery. Carry the included
small battery as an emergency backup.

2. Sense the Motion

WIDE-ANGLE LENS ADAPTER
A wide-angle lens can capture
more area within the frame,
among other things. For
example, you may be in a
situation where you want to
capture your friends standing
in front of a famous statue, but you
can’t physically back far enough away to
ﬁt both your friends and the statue into
the frame. A wide-angle lens can optically
“move back” from the subjects and the
background so that you might be able to
ﬁt everything in the frame.

When you’re manipulating the Ken Burns
Effect, make sure the motion makes
sense. For example, for the photograph
of the long streetcar, we started the
motion from the back of the streetcar and
panned to its front. Also make sure that
the duration is appropriate: If you pan
past a scene too quickly, you’ll give your
audience motion sickness. Once you get
all of your photos customized the way
you like, you can add a cross dissolve
from one photo to the next by selecting
all of them in the Timeline and selecting
Editing > Transitions > Cross Dissolve.

EXTERNAL MICROPHONE
Good sound can make a
movie “look” better. The
built-in microphones on
most camcorders are
mediocre at best, and since
they’re part of the camera body,
they can pick up camera noise.
Simply moving the microphone further
away from the camera and closer to the
subject makes a big difference, and
the only way to do that is to attach an
external microphone.

. 7X
E-CON
VERTER WD-34 0

For this slide of a streetcar, we panned
from the back of the car to the front—a
logical move.

There are tons of accessories you can add
onto your camera, but four are crucial:

WID

Customize the Ken Burns Effect by
adjusting the position and zoom of the
photo at the Start and End positions.

By default, iMovie has the Ken Burns
Effect turned on for photos, but you can
customize the way it works on each of
your images. In the Timeline, click the
first photo; if you don’t see a floating
transparent Photo Settings pane, click
Show Photo Settings at the right, under
your iPhoto thumbnails. Click the Play
arrow in the Preview pane to stop the
animated preview. Now, see the Start/
End slider in the Photo Settings box?
Drag the slider to the Start side, drag the
photo in the Clip Viewer to where you
want the Ken Burns Effect to start, and
adjust the zoom as needed. Then switch
the slider to the End side, move the photo
again, and adjust the zoom. Finally, set
the duration with the slider that runs
from the rabbit to the tortoise—the
default is 5 seconds. Preview the effect,
and when you’re happy with it, click
Update to apply the motion.

SUCCESSORIZE
FOR SHOOTING
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TUNE IT UP
Once you’ve sequenced all your clips, their timing is perfect, and the beautiful slide
show brings tears to your eyes every time you watch it, it’s time for the finishing touch:
audio. Our own video captured mostly environmental noise and a lot of silly remarks,
some of which we wanted to keep because they made the video more entertaining, but
some of which would be better replaced with music or separately recorded narration.
Start by displaying your movie’s volume level: Control-click or
Control-click on the
right-click in the Timeline, and choose Show Clip Volume Levels
(or select View > Show Clip Volume Levels). You’ll see a purple line
Timeline to see the
cutting through the clips at the 100 percent volume level.
volume levels.

1. Find the Quiet Parts
Play your movie and decide which parts have audio you want to hear and
which parts should be totally silent (so you can dub in music or narration
instead). For the segments that should be totally silent, select them in
the Timeline, click the Clip Audio volume slider below the Timeline, and
lower the volume to zero. You can also lower the
video’s sound instead of silencing it by clicking
Clicking the purple
and dragging the purple line to create volume
line allows you to
curves. Click the purple line and drag down to
raise and lower the
turn down the volume; click and drag up to turn
volume on selected
the volume back up.
parts of your video.

2. Original Soundtrack Available
Music adds heart to a movie and keeps your audience engaged. Click the Media
button and then Audio to see some sound effects, GarageBand demo songs, and
your iTunes library. We thought of bringing in the Race Car Drive By or the City
Morning sound effect, but thankfully we came to our senses and decided to just
use some good music. To add a song, locate it in the
Drag a song to the
list and drag it to the bottom (third) empty layer of the
third level of the
Timeline—it’ll snap to the beginning of a video clip, if
Timeline to add it to
you want. You can adjust its volume the same way you
your soundtrack. (The
did with the video clips; to adjust its length, turn off
second layer is for
Show Clip Volume Levels and drag the left and right ends
recording narration.)
of the audio clip to fit.

3. Tell Your Story
You might also want to narrate part of the video—if you’re going to put it on a DVD
and send it to your family, for example, when you won’t be there to explain what
they’re seeing. To add narration, you’ll first need to hook up a microphone to your
Mac (see “Mic Your Mac the Right Way,” p33), after which the Microphone level
meter in the Media pane should indicate that sound is being picked up. Find the
place in the movie where you want to start talking, and then press the red Record
button next to the Microphone meter. The movie will play
Add narration to
while your voice records to the second layer in the Timeline.
tell the story when
To stop the recording, press the Record button again, and
you can’t be there.
crop and adjust levels as needed.

RESIST TRANSITION TEMPTATIONS
iMovie HD makes all kinds of crazy transitions from Warp Out to Billow as easy as a single click—and that’s the problem. If you watch
any good movie, almost all the transitions between shots are simple cuts (no transition effects at all) or cross dissolves, where one
shot fades into another. Yes, we know Star Wars used funky transitions as a matter of style. You’re not making Star Wars. Stick with
cuts and dissolves in your video. Simple is tasteful. Fancy is amateur.
32
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MIC YOUR MAC THE RIGHT WAY
You want your movie’s audio to sound as good as—
or better than—your video looks. When you record
voiceovers, use a decent mic and a proper audio
interface. For you MacBook Pro, iBook, and
PowerBook users, that means forgetting that
your Mac even comes with a built-in mic.
You need three components to make this
work: a microphone, a cable, and an interface
to connect the cable to the Mac. You can ﬁnd
a good dynamic microphone in the $50 to $120
range, but even the $15 models you ﬁnd at Radio
Shack are better than a built-in ’Book mic. Next, you’ll
notice that most decent microphones require an XLR cable,
which has a circular connector with three pins or sockets on the

microphone end and a 1/4-inch jack on the other, so to get the
microphone’s signal into your Mac, you need an interface.
The best of the budget interfaces are USB-based, which
is perfectly ﬁne for recording voiceovers. Thanks to the
inner workings of your Mac, many of these interfaces
are plug-and-play, so once you make the physical
connections, your Mac is ready to record.
You can ﬁnd mics and cables at music stores,
home-electronics stores, and big drugstores. You can
purchase audio interfaces from companies such as
M-Audio (www.m-audio.com), Edirol (www.edirol.com),
and MOTU (www.motu.com) at most music stores, but you can
ﬁnd great deals online at zZounds.com (www.zzsounds.com),
Musician’s Friend (www.musiciansfriend.com), and others.

iDVD launches—and look! You can use the same Theme you used in your video for a DVD menu. That’s class.

PUT IT ON DISC
One step remains, and that’s to export the sequence into a movie that can be viewed by your
family and friends. You do this through the Share menu. To create a DVD, choose Share > iDVD;
this launches iDVD, where you can create a DVD menu that shares the same Theme as your
movie. You can also include additional material, such as photos that didn’t make it into the
slide show or the entire public-domain Market Street movie, as bonus DVD extras.
Congratulations, you’re done! Now you have a home movie you can be proud to show your
relatives at your next family gathering. And the next time you make a home video, remember
that creativity is the ticket—and iMovie lets you exercise that creativity. ■

During the day, Andrew
Tokuda, aka Digital Droo,
runs his video company, 3rd
Light Digital Media. At night, he
does sound design and music.
On weekends, he likes to take
walks on the beach and play
tennis. He is a Capricorn.
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Field Guide to WINDOWS XP

Windows XP
on Your Mac
By Roman Loyola

A

s blasphemous as it sounds, there are reasons why you might want to use Boot Camp to run Windows XP on your Intelbased Mac (see “Apple Opens Windows,” p10)—and not just because you can. Be forewarned, though, that Windows XP
has a language all its own. Here’s a quick guide to the terms you may run into as you install Windows XP and get it up and
running on your Mac.

Windows XP Editions
WINDOWS XP PROFESSIONAL
Designed for businesses and power users. If you can’t decide
between buying the Home or Professional Editions, go Pro if you
want ﬁle encryption, the ability to restrict access to selected
ﬁles and apps, and better user-management tools if you plan on
having more than one person using Windows XP on your Mac.

WINDOWS XP HOME EDITION
This is the version of Windows most consumers use. It’s
cheaper than Professional, but it lacks many features that

Professional has, including multiprocessor support, ﬁle
encryption, expanded remote-desktop features, and more.

SERVICE PACK 2
Windows occasionally releases its OS updates as Service
Packs. These updates contain previously released ﬁxes and
patches—kinda sorta like the Combo Updaters for Mac OS
X. When installing Windows XP on your Mac, you must use
a Windows XP with Service Pack 2 installer; you can’t use
previous versions.

Installation Glossary
DUAL BOOT

QUICK FORMAT

A computer that’s set up with two operating systems. To choose
which operating system you want to use on your dual-booting
Mac, hold down the Option key during startup; two hard drive
icons will appear, representing Mac OS X and Windows XP.

During XP installation, you need to format your Windows XP
hard-drive partition. A quick format doesn’t perform a scan
for bad sectors.

NTFS

Windows XP’s answer to Mac OS X’s Software Update.
Windows XP uses an Internet connection to check with
Microsoft for any operating-system or Microsoft-application
updates. At installation, you can set it to run automatically or
manually. You can change this setting in the Security Center
Control Panel after XP is installed.

Short for “NT File System,” this is a journaled ﬁle system used
by Windows XP. It has support for ﬁle security, multiple data
streams, built-in ﬁle compression, and more. Mac OS X can read
ﬁles on an NTFS partition, but it can’t write to that partition.

FAT32
Short for “File Allocation Table 32-bit,” this is a basic ﬁle
system used by Windows XP. It lacks security features and has
a 4GB ﬁle limit. Mac OS X can both read from and write to FAT32
partitions.

AUTOMATIC UPDATES

WINDOWS ACTIVATION

C: DRIVE

Microsoft’s form of copy protection against users who
install pirated versions of Windows XP. After Windows XP is
fully installed, it needs to be activated within 30 days, or it
becomes unusable. Activation can be done over the phone
or over an Internet connection.

Partitions in Windows are given letter labels, and the default
label for the Windows startup drive is the euphoniously named
C: Drive. When you use Boot Camp, it creates a C: partition—
use this partition for your Windows XP installation.

This is a utility that Windows uses to take you step-by-step
through a setup process.
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WIZARD

Interface Items
1

START MENU

This is analogous to Mac OS X’s Dock. Click
Start, and a two-sided list appears. On the left
are permanently listed items (top), recently used
applications (middle), and a pop-up menu of
all your apps (bottom). On the right are items
you might want to access quickly, such as your
hard drive, recent documents, the Control Panel
(Windows’ version of System Preferences), search
functions, help options, and more.
2

9

3

5
2

4

MY COMPUTER

Double-click My Computer, and you’ll open a
window that lets you access your storage devices,
attached cameras, and folders.
3

WINDOWS EXPLORER

Whenever you double-click a folder or storage
6
1
device to see its contents, the window that opens
is actually part of an app called Windows Explorer—
think of it as Windows’ feeble knockoff of the Finder in Mac OS X.
The left pane contains a context-sensitive list of things you can do
with the item you click in the right pane.
4

MY NETWORK PLACES

Double-click here to open a window that shows the wired or
wireless connections for your Mac.
5

MY DOCUMENTS

Default folder for storing your documents—just like the Documents
folder on your Mac.

7

7

QUICK LAUNCH

One-click access to apps, ﬁles, or folders. Drag and drop icons to
this spot to add items.

TASKBAR

Whenever you launch an app, a horizontal button will appear
here. Click the button to bring that app to the foreground. Click
it again to hide the app. You can also switch between apps by
pressing Command-Tab on your keyboard.
8

SYSTEM TRAY

Holds shortcuts to apps that are running in the background.
System-notiﬁcation message balloons also appear here to inform
you of system activities, such as when a USB device is attached.
9

6

8

MINIMIZE, MAXIMIZE, AND CLOSE

These buttons appear on every window and are similar to those
on the Mac, but they’re in a different order and on the opposite
side of the window—just to be contrarian, we assume.

Behind Windows
BIOS

CONTROL KEY

Acronym for “Basic Input/Output System” or “Basic Integrated
Operating System,” depending on whom you ask. Commonly
found on PCs, the BIOS contains the code the computer runs
before launching Windows XP.

The Control key on your keyboard is used for keyboard shortcuts
and is analogous to the Command key in Mac OS X. Many
Windows shortcuts use same key combo as Mac OS X. For
example, Cut is Control-X; Copy is Control-C; and Paste is Control-V.

EFI

REGISTRY

Acronym for “Extensible Firmware Interface.” On Intel-based
Macs, the EFI takes the place of the BIOS used on PCs.

A database where
Windows XP keeps
all of its user,
application, and
operating-system
settings.

.EXE
File extension that stands for “executable.” This extension
indicates an application that you can run in Windows.

Roman Loyola actually uses Windows XP at home (yes, he’s a masochist) and Mac OS X at work.
He’s searching for room in his home to install a computer that runs Linux.

The Registry is for Windows XPerts only.
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RATIN¬S
You’ll be
blown away.

You’ll be
impressed.

You’ll be
satisfied.

You’ll be
disappointed.

You’ll be
pissed off.
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better living through smarter shopping

We tend to focus on practicality when it comes to deciding
what to buy, but when a product looks as unique as the JBL On
Time (pictured), it’s hard not to ignore artful aesthetics. Next
month, we focus on Adobe’s After Effects 7 video-effects app,
Bare Bones Software’s Yojimbo data organizer, SmartDisk’s
FlashTrax XT portable media player and recorder, and more.

38 1.5GHz Intel Core Solo Mac mini desktop Mac
38 1.66GHz Intel Core Duo Mac mini desktop Mac
55 browseback Web utility
43 Combustion 4 visual-effects software
42 D-LUX 2 point-and-shoot camera
41 Freeway 4 Express Web-design software
40 Freeway 4 Pro Web-design software
49 JBL On Time iPod alarm clock
54 MultiSync 20WMGX 2 LCD display
46 Olive Symphony digital-music server
50 particleIllusion animation software
48 Podcast Factory podcast hardware/software combo
44 PureAV RemoteTV TV transmitter
47 Reunion 8 genealogy software
52 Suitcase Fusion font-management software

PHOTOGRAPH BY SAMANTHA BERG

Games

57 Call of Duty 2 tips and tricks
59 HoppiX game review
59 Imperial Glory coming soon
57 Minions of Mirth game review
59 RollerCoaster Tycoon 3: Soaked coming soon
58 Sid Meier’s Civilization III: Complete game review

We’d spend our
own hard-earned
money on this
product.

Universal application
that runs natively on
both PowerPC and
Intel Macs.
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1.5GHz Intel Core Solo Mac mini
1.66GHz Intel Core Duo Mac mini
COMPACT, INTEL-IFIED DESKTOP MACS

Still cute on the
outside, but the inner
workings are all new.

A

pple’s Intel integration marches on,
and the Mac mini is the latest to join
the parade. After taking a close look at
the 1.5GHz Intel Core Solo Mac mini and
1.66GHz Intel Core Duo Mac mini, we
came to the same conclusion we did with
the MacBook Pros (Reviews, May/06,
p36) and Intel-based iMacs (Reviews,
Apr/06, p40): Whether you should buy
a new Mac mini now or wait until later
depends on whether the apps you use
are available in Universal format. But
hey, you want details (and we have two
pages to ﬁll), so read on.
Let’s start with specs. There are two
different models: a $599 mini with a
1.5GHz Intel Core Solo processor, and
a $799 mini with a 1.66GHz Intel Core
Duo processor. Quick quiz: If the Core
Duo has two processor cores on one chip
(hence the Duo), can you ﬁgure out how
many processor cores the Core Solo has?
That’s right: one! While you make your
way to the head of the class, here are
the other key specs that are the same
38
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on both minis: a 2MB L2 cache (which is
shared by both cores on the Core Duo),
a 667MHz frontside bus, 512MB of RAM
(2GB maximum) installed as a pair of
256MB SO DIMMs, and built-in AirPort
Extreme and Bluetooth.
Both Mac minis also use an Intel
GMA950 graphics processor, but unlike
the previous Mac mini (which had 32MB
of dedicated video RAM), the new Mac
minis’ graphics processors use 64MB,
shared with the main memory. We’re not
big fans of the whole shared-memory
thing; it effectively cuts down the amount
of memory available for the Mac to use,
and dedicated video RAM usually helps
graphics performance. Speaking of
which, when we ran the Intel-native Doom
3 benchmark, we were disappointed
with the results—while both Intel Mac
minis were 9 percent faster than the
1.42GHz G4 Mac mini, the Intel minis
posted results in the 6-frames-persecond range—you’ll spend most of your
time either getting sick from the choppy

animation or being mercilessly fragged.
The Mac mini is not a gamer’s Mac.
More specs: The Core Duo Mac mini
comes standard with a 5,400rpm 80GB Serial ATA hard
drive and a double-layer
(yay!) SuperDrive. The
Core Solo Mac mini comes
standard with a 5,400rpm 60GB Serial ATA
hard drive and a combo
drive—you can’t burn DVDs
with it.
Apple reconﬁgured the
rear ports on the new Mac
minis. There are now four USB
ports (there were previously
two), one FireWire 400 port, a
new optical digital/analog audio
input port to go along with the optical
digital/analog audio-out jack, and
Gigabit Ethernet. Say goodbye to the
built-in modem; if you need one, you can
shell out $49 for Apple’s USB Modem.
Media mini. When the Mac mini was
initially released, there was a lot of talk
in the Mac community about using it as
a digital entertainment hub—the only
thing missing was an easy way to access
your Mac’s videos, songs, and photos.
The new minis, however, include Front
Row, Apple’s media interface that works
with the included Apple Remote control.
You can connect the Mac mini to a TV,
but you’ll need to use Apple’s $19 Video
Adapter, which connects the Mac mini’s
DVI port to any S-Video or composite
TV. You’ll also need to connect an audio
cable from the Mac mini to your TV.
The Mac minis worked ﬁne with our
TV, but if you plan on integrating the
mini into your home entertainment
center, consider using the built-in
Bluetooth for a wireless keyboard
and mouse. Even though Front Row
works well with the Apple Remote,
there will be times when you need to
use a keyboard and mouse to access
your Mac. And considering that there’s
probably already more than enough stuff
in your home entertainment center—TV,
cable box, DVR, DVD player, receiver,
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faster. When
importing 196
photos into iPhoto,
the Core Solo Mac
mini was 2 percent
faster, while the
Core Duo Mac mini
was 7 percent
faster. In our iDVD
Save As Disc Image
test, the Core Solo
and G4 Mac mini
Look ma, no modem! And fewer air vents needed, as well.
posted similar
times, while the Core Duo Mac mini was
game console, Betamax player—it’s
11 percent faster than the G4 Mac mini.
handy to be able to whip out a cableIf you’ve been paying attention to
free keyboard and mouse. You can use
our past test results, you already know
Apple’s Wireless Keyboard ($59) and
what we’re going to say about the Intel
Wireless Mouse ($59, a one-button job)
Mac minis’ speed when using software
or some other Mac-compatible Bluetooth
that runs under Rosetta: It’s slow. For
input devices.
example, the G4 Mac mini was 50 percent
Speed. We tested the Mac minis using
faster than the Core Duo Mac mini and
a suite of tests that involved both Intel57 percent faster than the Core Solo Mac
native software and apps that run using
mini in our Adobe Photoshop Elements 4
Rosetta, Apple’s PowerPC-to-Intel code
Auto Enhance test. When performing an
translator. For reference, we dusted off
Adobe InDesign CS PDF Export, the G4
our G4-based 1.42GHz Mac mini and
Mac mini was over 60 percent faster than
popped in 512MB of RAM to match the
both Intel Mac minis. And in our Adobe
Intel Mac minis’ standard conﬁgurations.
Photoshop CS2 Action test, the G4 Mac
Our earlier Intel Mac test results showed
mini was 67 percent faster than the Core
that when using software native to
Solo Mac mini and 62 percent faster than
the relative processor, the Intel Macs
the Core Duo Mac mini.
are faster than PowerPC-based Macs.
A couple of tests gave us curious
Predictably, this still holds true with
results. For example, in our GarageBand
the Mac minis. When applying a Sepia
Send To iTunes test, the G4 Mac mini
Tone Video FX effect in iMovie HD, for
was 19 percent faster than the Core Solo
example, the Core Solo Mac mini was
Mac mini, and a full 40 percent faster
41 percent faster than the G4 Mac mini;
the Core Duo Mac mini was 57 percent
than the Core Duo Mac mini. When we

RAM Upgrade: Under Cover
Upgrading the G4-based Mac mini was an exercise in putty-knife surgery (see
“Max Out Your Mac mini,” May/05, p54), but it was smooth sailing once you got the
thing open. Not so with the new Mac minis. RAM is no longer conveniently located
in a slot along the Mac mini’s side—it’s now underneath the drive chassis that sits
above the motherboard. Doh! You have to remove four screws that hold the chassis
down, disconnect (carefully!) a few wires, and then separate (carefully!) the chassis
and motherboard. Once separated, you can easily access the SO DIMM slots.

Apple says to upgrade your
Mac mini’s SO DIMMs in pairs
to get better performance.

used QuickTime Pro to convert a DV
movie to an H.264 QuickTime movie, the
G4 Mac mini was 34 percent faster than
the Core Solo Mac mini—but the Core
Duo Mac mini was 22 percent faster than
the G4 Mac mini and almost twice as fast
as the Core Solo. At press time, Apple
had yet to respond to our questions
about these oddball results.
The bottom line. There’s a lot to
consider when it comes to the new Mac
minis. If you’ve been saving a spot in
your home entertainment center for an
affordable Mac, you can now ﬁll it with
a Front Row–equipped Mac mini—that’s
an easy decision to make. If you already
have a Mac mini and are using apps
such as iLife or iWork along with basic
home-ofﬁce stuff (email, Web, personal
ﬁnances, your kids’ homework, and
so on), the Core Duo Mac mini is a nice
upgrade—but you might want to think
about scrounging up another $500 for
the $1,299 17-inch iMac. If you want a
new Mac setup, either Mac mini will do
for nonprofessional apps. But if your
apps aren’t Universal, you’re not getting
top performance.—Roman Loyola

COMPANY: Apple
CONTACT: 800-692-7753 or 408-996-1010,
www.apple.com
PRICE: $599 (1.5GHz Core Solo), $799 (1.66GHz
Core Duo)
SPECIFICATIONS:
1.5GHz Intel Core Solo: 2MB L2 cache, 667MHz
frontside bus, 512MB 667MHz DDR2 SDRAM, 60GB
5,400-rpm Serial ATA hard drive, combo drive, Intel
GMA950 graphics processor with 64MB DDR2
SDRAM (shared with main memory), built-in AirPort
Extreme and Bluetooth 2.0, Gigabit Ethernet
1.66GHz Intel Core Duo: 2MB L2 cache, 667MHz
frontside bus, 512MB 667MHz DDR2 SDRAM, 80GB
5,400-rpm Serial ATA hard drive, SuperDrive, Intel
GMA950 graphics processor with 64MB DDR2
SDRAM (shared with main memory), built-in AirPort
Extreme and Bluetooth 2.0, Gigabit Ethernet
GOOD NEWS: Good speed boost over G4-based
Mac mini when using Universal applications. Small
footprint doesn’t use a lot of space. Core Duo model
comes with double-layer SuperDrive.
BAD NEWS: Performance hit using non-native apps
with Rosetta. Unimpressive video performance. Tough
to upgrade RAM yourself. Only one FireWire port.

1.5GHz Intel Core
Solo Mac mini

1.66GHz Intel Core
Duo Mac mini
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Freeway 4 Pro
CODE-FREE WEB-DESIGN APP
the familiar Cocoa look. You can
preview your page in your favorite
browser or in the Freeway window.
You can also open more than one
window with the current page, so
you can, for example, see your
editing view in one window and
a zoomed view in another—handy.
One of version 4’s big new
features is the ability to position
page elements using CSS instead
of tables. Because Freeway
handles all the code generation,
you don’t need to know anything
about CSS—you simply click the
CSS Layout button in the toolbar.
Freeway provides an excellent
dialog for building and editing CSS
text styles, making a potentially
confusing process easy and clear.
Freeway has the unique ability
to convert styled, editable
text into a GIF, JPEG, or PNG
graphic. This allows you to create
graphical headlines using any
fonts on your system directly
in Freeway, saving you from
Freeway 4 Pro is ideal for the code-phobic, but if you want to be taken seriously as a Web designer,
prepping your text in a separate
you’ll need to get over those fears.
graphics program. You have
vast control over the graphical text; you
QuarkXPress or Adobe InDesign, you
reeway 4 Pro takes a page from
can add glows, borders, shadows, and
draw boxes that act as containers for
desktop publishing by using a
transparency effects; plus, Freeway
text, graphics, or multimedia elements.
page-layout approach (à la QuarkXPress
automatically anti-aliases the graphic
You can also have the containers snap
or Adobe InDesign), allowing you to
against its background.
to guides or a grid for easy alignment.
construct Web sites with virtually no
Freeway has long allowed the use
You begin by building one or more
coding knowledge. While other Webof JavaScript for page effects such as
master pages from scratch or based on
design apps provide a visual interface
rollovers, but again, you don’t have
one of the included templates. Items
to underlying code, Freeway generates
to worry about programming; you just
added to a master page automatically
HTML or XHTML code only when you
apply the compiled JavaScript effects,
appear on any pages that use that
preview or publish a page.
which are called Actions. Several
master, making it easy to maintain a
Web-design apps such as Macromedia
Actions come with the app, and you
consistent look. To add content to a
Dreamweaver and Adobe GoLive require
can download many more from the
new page, you import text or graphics
you to build pages with layouts that are
Softpress Web site or third parties. For
by dragging and dropping them from
dependent on HTML and CSS properties.
advanced users who want to create
the Finder or another application. If you
In Freeway, you create sites based on
dynamic, database-driven sites,
have a lot of text, there are tools that
master pages with elements—nav bars,
Freeway 4 Pro’s new Markup dialog
let you link and unlink long text ﬂows
banners, headers,
ON THE
allows you to add programming code
between text boxes.
and footers—that are
DISC shared across the
to your pages and attach that code to
New stuff. With version 4, Freeway Pro
Freeway 4 Pro
speciﬁc page elements. You can use any
offers an updated user interface with
site’s pages. As in

F

COMPANY: Softpress Systems
REQUIREMENTS:
CONTACT: 415-331-4820 or
Mac OS 10.2.8 or later
800-853-6454, www.softpress.com
PRICE: $279 (retail), $249 (download)
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GOOD NEWS: Fast learning curve for print designers. Excellent
ability to turn styled text into graphics. Easy CSS styling.
BAD NEWS: Poor importing of existing HTML pages. No access to
underlying code. Unique approach may confuse veteran Web designers.
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How long can
you afford to
be without
your data?
No matter what happens to
your data, you’re back to work
IMMEDIATELY with SoftRAID 3
If your hard disk fails…
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You keep working from the healthy disks in
your Mirror volume.

If your data is stolen or destroyed…
Plug in your archived SoftRAID disk, start
up, and you are good to go.

Get a free demo at
www.softraid.com
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SoftRAID, LLC

44801 Main Street
P.O. Box 1600
Mendocino, CA 95460-1600
SoftRAID is a trademark of SoftRAID LLC
Mac and the Mac logo are trademarks of
Apple Computer, Inc., registered in the U.S.
and other countries.
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D-LUX 2
WIDESCREEN POINT-AND-SHOOT CAMERA
A sharp lens and 16:9
sensor produce excellent
widescreen photos.

M

ac displays and TVs are going
widescreen, so why not your
camera? It’s not surprising that Leica’s
D-LUX 2 snaps pictures in widescreen
format—after all, Leica was the ﬁrst
camera company to effectively use
35mm ﬁlm in its still cameras.
The D-LUX 2 uses an excellent Leica
DC Vario-Elmarit f/2.8-to-f/4.9, 6.3mmto-25.2mm, 4x zoom lens and Panasonic
electronic innards. At 4.16 by 2.28 by
1 inches, the rounded, smooth camera
is small, yet feels substantial. It has no
viewﬁnder, only a large 2.5-inch LCD.
The controls on the D-LUX 2 are
positioned intelligently and are easy
to learn. Almost all adjustments that
you’d normally make while shooting
are accessible without digging through
menus. The camera offers manual
control along with a full range of
shooting presets, including Baby,
Candle, Fireworks, Food, Landscape,
Night Portrait, Night Scenery, Party,
Portrait, Self-Portrait, Snow, Soft Skin,
Sport, and Starry Sky.
COMPANY: Leica
CONTACT: 800-222-0118,
www.leica-camera.com
PRICE: $799.95
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Aspect ratio. At the top of the lens
barrel, you’ll immediately notice a
switch marked Aspect and the numbers
4:3, 3:2, and 16:9. Most cameras use
sensors with a 4:3 aspect ratio and
offer wide ratios by cropping the top
and bottom of an image. The D-LUX 2,
however, uses a 16:9 sensor and crops
images at the sides when you want 4:3
and 3:2 ratios. When you shoot at 16:9,
the camera can use all 8.4 megapixels
of its CCD; at 3:2, the maximum is
7 megapixels; at 4:3, the max is 6
megapixels. When you shoot in RAW
format, the RAW image ﬁle is always
16:9, and the accompanying JPEG is
at your chosen aspect ratio. We found
ourselves leaving the aspect ratio set
at 16:9 and cropping the image down
to size on our Mac.
If you do decide to shoot in RAW
format, buy a high-speed, high-capacity
SD memory card—the D-LUX 2 comes
with a paltry 64MB card; if you shoot
16:9 RAW, you’ll only be able to ﬁt three
images on it. When we used a 1GB,

REQUIREMENTS:
USB-equipped Mac

40x-speed Lexar Platinum
SD card, we were surprised
by the speed boost. We
were able to shoot RAW
at a comfortable pace
without suffering the long
write times we’re used to
with most consumer-level
cameras that shoot RAW.
The only thing that
disappointed us about
using the D-LUX 2 was
image noise. There are
four sensitivity-level
settings for the image
sensor: ISO 80, 100, 200,
and 400. For all practical
purposes, the differences between ISO
80 and 100 are nonexistent—images
were sharp, clean, and only exhibited a
bit of noise in shadow areas, a common
failing on small-sensor digital cameras
(though the D-LUX 2 is better than
most). The real problems start when
you increase the ISO to 200—and
even more so when you go up to 400.
The entire image develops a speckled
multicolored noise pattern that
probably won’t upset most people, but
the noise can’t be completely removed,
even with the best noise-reduction
software. Our recommendation is
to use the ISO 80 and RAW settings
whenever possible.
The D-LUX 2 also comes with a copy
of Photoshop Elements 3, which you
can use to enhance your RAW image
ﬁles on your Mac.
The bottom line. Despite the
disappointing image noise at high ISO
settings, Leica’s D-LUX 2 is capable of
producing high-quality photographs.
It’s the type of camera you’ll want to
carry with you everywhere you go.
—George Mann

GOOD NEWS: Pocket sized. 16:9 native chip aspect
ratio. Capable of shooting RAW without long write times.
BAD NEWS: Some noise at higher ISO ratings.
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Combustion 4
POWERFUL VISUAL-EFFECTS SOFTWARE

Despite the un-Mac-like interface, Combustion 4 has excellent improvements.

C

ombustion 4 is a big, bodacious
visual-effects app that serves up
loads of pro-level tools; think of it as a
competitor to Adobe After Effects Pro.
Many effects artists—especially folks
familiar with Autodesk’s big-iron effects
workstations—prefer Combustion’s
unique way of doing things, and the latest
version won’t disappoint that crowd.
Combustion turns your whole screen
(or screens) into one giant window with
context-sensitive controls. Like After
Effects, Combustion offers tons of keying
and compositing features, vector paint
tools, particle systems, motion tracking,
image stabilization, and effects ﬁlters
(though After Effects has about twice
as many ﬁlters). But while After Effects
uses Photoshop-style layers to build its
effects, Combustion uses a connect-thenode paradigm similar to Apple’s Shake.
Capsules are one of the new big-ticket
features you’ll come to know and love.
A Capsule is a collection of multiple
COMPANY: Autodesk
CONTACT: 800-440-4198,
www.autodesk.com
PRICE: $999 (full), $299 to $399 (upgrade)

operators that you can apply again
and again in your projects. Say you’ve
carefully handcrafted a stylized look for
your video, involving operator values
for color correction, ﬁlm grain, shutter
info, blur, and so on. Just save all these
operators as a single Capsule, and you
can apply the Capsule to any footage with
just a couple of clicks. You can even
email the Capsule to colleagues so they
don’t have to reinvent the wheel. You can
edit each operator value you’ve included
in the Capsule and create minimum and
maximum settings for those values to
prevent others from tinkering too much
with the effect. Capsules are great
tools for maintaining a consistent look
among a number of effects artists, but
Capsules don’t work in other Autodesk
products, just the Mac and Windows
versions of Combustion.
Motion control. Combustion 4 is
now much better at creating slow- or
fast-motion video effects. In earlier

REQUIREMENTS: 800MHz
G4, Mac OS 10.2 or later, 512MB
RAM, 120MB disk space

versions, you could only play video
at a constant speed; now, a new
operator called Timewarp lets you
slow down, speed up, or reverse
video precisely when you want
the effects to occur. Timewarp
grants you tons of creative control,
letting you set keyframes, choose
interpolation modes, and more,
but expect to spend at least a few
hours discerning the mysteries
of Timewarp’s interface, which
involves some intimidating charts
and graphs.
Combustion’s new Diamond Keyer
operator is an advanced keying tool
based on the Color Warper Keyer
found in Discreet’s Flint, Flame,
and Inferno workstations. Diamond
Keyer is both powerful and easy to
use: Its interface consists of a single
panel of intuitive controls; you can
use six presets for luma and chroma
keying to grab an alpha matte in
seconds, and then hone your key
with some additional controls such as
tolerance and softness. Spill suppression
and matte reﬁnement, however, are
applied as separate operators outside
the Diamond Keyer interface. You may
wish these functions were built in
directly, but the Diamond Keyer focuses
on the most-common keying tasks,
making them almost instant. And sure
enough, we were able to pull a number of
keys that needed no additional futzing.
Other handy additions: The G-Buffer
Builder takes the manual labor out of
applying 3D lighting, fog, and depth-ofﬁeld effects; the Compare tool lets you
split a video frame and compare it side by
side with another image; and the layout
guide offers handy snap-to properties.
The bottom line. Combustion 4 offers
plenty to newcomers and loyal fans
alike. If $999 seems steep, consider the
$2,999 sticker on Apple’s Shake, which
itself is a bargain by the rich standards
of the effects industry.—Helmut Kobler

GOOD NEWS: Fantastic new keyer. Sophisticated
time-remapping tool. Time-saving Capsules.
BAD NEWS: Un-Mac-like interface. Crashes
occasionally.
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Mirror your TV reception
to other TVs in your home.

PureAV RemoteTV
WIRELESS TV TRANSMITTER

B

elkin’s PureAV RemoteTV takes
video from a cable-TV box, DVD
player, or other source hooked up to
your main TV, and sends it wirelessly
to another TV—even one in a different
room. If you want to share the latest
pay-per-view movie with the kids in the
kitchen while you relax in your La-Z-Boy
in front of your home entertainment
center, the RemoteTV allows you to do
so with very little hassle. You can even
use it with your Mac (we’ll get to those
details in a minute).
The RemoteTV has two components: a
transmitter and receiver. The transmitter
converts analog video and audio input
into an MPEG-2 stream and sends it to
the receiver via a proprietary version
of the 802.11a wireless protocol. The
receiver then converts the data back
into analog form and outputs it to the
destination TV. It’s simple to set up—
no software to ﬁddle with or network
settings to conﬁgure. All you have
COMPANY: Belkin
CONTACT: 800-223-5546,
www.belkin.com
PRICE: $499
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to do is connect your source to the
transmitter (the Remote TV supports
composite, component, S-Video, and
RCA audio input and output), connect the
transmitter to your main TV, and attach
the receiver to your other TV. Power
everything up, and enjoy.
Simply put, the RemoteTV works.
We connected several different video
devices, used each input option on
the transmitter, and consistently got
clear, smooth video with no stuttering
or noticeable degradation in quality.
However, video is limited to standard
480i resolution; given the current HD
trend, it would’ve been nice to see
higher resolutions. Also, the RemoteTV
has no built-in tuner features of its
own, so you’ll have to make sure that
whoever’s on the other end is OK with
watching what you’re watching.
The RemoteTV comes with a Remote
Control Extender that lets you control the
TV connected to the transmitter while

REQUIREMENTS:
Video devices with composite,
component, or S-Video out

you’re in another room. It’s a
huge convenience—no need
to run back and forth between
rooms to change the channel.
Mirrored Mac. While the
RemoteTV is primarily intended
for TV output, it also works with
your Mac. We took a MacBook
Pro (because it’s easy to carry
and has Front Row, but you can
use any Mac you wish) and
used Apple’s DVI to Video
Adapter ($19, www.apple
.com) to connect to the
RemoteTV via composite
video. We used a 3.5mmstereo-mini–to–RCA adapter and RCA
cables to connect the ’Book’s audio-out
port to the transmitter’s stereo audioin port. We then connected a TV to the
transmitter so we could monitor what we
were doing on our Mac. In another room,
we connected the receiver to a TV.
Sending video from our Mac this way
worked, but we did run into some hitches.
That 480i limit we mentioned earlier? If
you’re transmitting to a big widescreen
TV, you’ll have some video-scaling
issues—in our testing with a 60-inch
Panasonic PT-60LCX63, the video didn’t
ﬁll the screen, and the image quality
was jaggy. If you use a Mac with high
video-resolution support, you’ll get better
image quality, but the 480i limit will
restrict your screen size. One last thing:
You need to be in the same room as your
Mac to control it. That’s not such a big
deal if your Mac is in the same room as
your television, but it’s inconvenient if
your Mac is somewhere else.
The bottom line. The RemoteTV
solidly does what it sets out to do, but
you should consider its limitations
before you shell out the $499. If you’d
primarily use it for TV, it would probably
be cheaper to just extend your cable or
satellite connection to your other rooms.
—Gil Loyola, Roman Loyola, and
Michelle Victoria

GOOD NEWS: Easy to set up. Great TV video quality.
BAD NEWS: Only duplicates content from source.
No HD support. Pricey.
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Olive Symphony
DO-EVERYTHING DIGITAL MUSIC SERVER

O

live Media Products calls its
Symphony a “wireless music
center.” It’s a single device that handles
pretty much every listening-to-digitalmusic function you can think of: It rips,
mixes, and burns music to CD; plays
music; streams tunes to your Mac; and
uploads songs to an iPod. It’s great—
unless you have a Mac, which already
does most of what the Symphony can.
The Symphony comes with an 80GB
hard disk and a CD drive. It’s shaped
like a stereo component, with goldplated RCA jacks in addition to four
Ethernet, two USB, and two S/PDIF
ports. The most basic use of the
Symphony is to rip your CDs to its hard
disk—you can copy in FLAC (a lossless
compression format), MP3, AIFF, or
WAV—and play the music back through
your stereo. The Symphony plays music
in the aforementioned formats plus
Ogg Vorbis, WMA, and AAC (though not
protected AAC songs purchased from
the iTunes Music Store).
Music transferred directly to the
hard drive sounds great, especially
when stored in FLAC format—songs
are essentially indistinguishable from
CDs played on a good CD player. The
Symphony has a special quiet hard
drive, a custom low-noise power supply,
and no fan, so there’s no distracting
equipment noise. Olive also touts the
quality of the Symphony’s CD player,
but on our unit, the CD drive made
the same kind of noises your Mac’s CD
drive does—that’s ﬁne for ripping, but it
interferes with music listening.
COMPANY: Olive Media Products
CONTACT: 877-296-5483,
www.olive.us
PRICE: $899
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Once you’ve transferred your tunes,
the Symphony becomes an all-purpose
music server. Aside from just playing
songs through your stereo, you can use
the Symphony’s Ethernet or 802.11g
wireless-networking capability to
stream audio to your Mac, or stream
your Mac’s music to your stereo. You
can also connect your iPod to one of the
Symphony’s USB ports and copy music
from the Symphony to the iPod (though
not the other way around) or play music
from the iPod through the Symphony.
The Symphony can also help you
digitize an extensive vinyl or cassette
collection. Since the Symphony plugs into
your stereo system, it can digitize music
from any of your other components, such
as your turntable or tape deck. It can
also burn CDs of your digitized music,
provided you use CDs labeled as Music
CD-Rs (rather than the cheaper data
CD-Rs you probably often use).
Some stumbles. It’s frustrating to
have to scroll through menus on the
Symphony’s little iPod-like 3.25-inchwide, 400-by-160-pixel screen to do
anything. The primary control consists
of two concentric jog wheels—the inner
wheel scrolls through the menus, while
the outer wheel makes a selection or
moves back through the menus. The
Symphony’s long list of capabilities
means you have to navigate extensive
hierarchical menus, and since the screen
is small, you have to do it while standing
or sitting within arm’s reach of the unit.
A remote control with a screen would
improve the Symphony tremendously.

REQUIREMENTS:
Stereo with audio-in jack

The Symphony offers a nice way to
integrate digital music into your home
entertainment center, if you’d rather
leave your Mac out of the picture.

Not everything worked every time,
either. Copying CDs to the hard disk:
no problem. But one of our recordings
from a cassette ended up with a digital
stutter that made it unlistenable.
Also, when streaming from iTunes,
changing a playlist would often cause
the Symphony to lose its connection
with iTunes; it would then refuse to
reconnect without rebooting (the
Symphony, not the Mac). No error
messages popped up to explain the
glitches, so we were left scratching
our heads and just trying again, never
knowing what went wrong the ﬁrst time.
The bottom line. The Symphony is a
fairly complete and mostly satisfactory
digital music package—but so is
your Mac, and you can add the Roku
SoundBridge ($149.99 to $199.99,
www.rokulabs.com) or Apple’s $129
AirPort Express (
Oct/04,
p48) to handle streaming from iTunes
to your stereo, and ADS Tech’s Instant
Music ($49.99, www.adstech.com) to
attach an analog music source to your
Mac. Putting all of those functions
in one stereo component and using
it to clear the CDs, tapes, and vinyl
(not to mention your cassette deck
and turntable) out of your living room
deﬁnitely has appeal—but for someone
who already has a Mac, probably not
$899 worth.—Jake Widman

GOOD NEWS: Integrates with your stereo system.
Handles most digital music functions.
BAD NEWS: Awkward controls. Duplicates many
musical functions that the Mac can already perform.
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40 watts of LOUD
portable power
Be the biggest bass in the place.
Designed to work with nearly any
portable music source, the BoomTube
H201 portable speaker system
transforms personalMP3 players,
cellular MP3 phone and even notebook
computers into a portable party. The
built-in rechargeable lithium-ion batteries
keep the sound pumping for up to 5
hours on a charge, and the whole
package fits neatly in a backpack
or overnight bag for go-anywhere
portability. So...why are you still here?
Available at:
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www.thinkoutside.com
10 South 3rd Street
San Jose, California 95113
408.297.5100
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Quality hardware for making
quality podcast audio.

Podcast Factory
ALMOST-COMPLETE PODCAST-CREATION KIT

M

for your audio input and output, and
-Audio makes it easy to jump on
you’re close to done.
the podcasting bandwagon with
Software. If the Fast Track is the heart
Podcast Factory, an almost-complete
of Podcast Factory, then the bundled
podcasting package that includes a
software is the brain. You record and
microphone (with desktop stand), audio
edit your voice using Audacity, an
interface, cables, and software (sans
audio editor; assemble and polish
Web server).
the show using the included Ableton
The heart of Podcast Factory is the Fast
Live Lite (a multitrack DAW, aka digital
Track USB-powered audio interface that
handles up to 24-bit/
48KHz audio resolution,
making it useful even for
professional recording.
For I/O, the interface box
sports a mic-level XLR input,
switchable instrument/linelevel quarter-inch input,
headphone minijack, and
stereo RCA outputs. There
are three knobs: mic input,
headphone output, and one
for balancing the volume
between the input and
playback signals. The dynamic
microphone is quite capable
and doesn’t require phantom Podcast Factory includes Audacity for editing your audio.
power—a good thing, since
audio workstation) and M-Audio’s
the Fast Track doesn’t provide it.
ProSessions loops; and publish your
Setting up Podcast Factory couldn’t
podcast to the Web using Podiﬁer, an
be easier. Just connect the included
MP3-centric RSS and XML publisher
USB cable from the Fast Track to a USB
(you’ll need to take care of Web hosting
port on your Mac, and open System
on your own).
Preferences > Sound. Select Fast Track
COMPANY: M-Audio
CONTACT: 626-633-9050,
www.m-audio.com
PRICE: $179.95
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REQUIREMENTS: 350MHz G4,
Mac OS 10.2.8 or later, 128MB RAM

Audacity and Live Lite are great apps,
but they’re not the be-all and end-all
of podcast recording. Luckily, Podcast
Factory’s plug-and-play hardware and
friendliness toward Audio Units plug-ins
mean you can use just about any Mac
app for recording, including Apple’s own
GarageBand. In this sense, it’s good
that the Podcast Factory hardware is
nonproprietary.
Unfortunately, Podiﬁer—the
included cross-platform RSS/XML
publishing software—is simply
awful, and the Windows version
has features the Mac version
lacks. Luckily, you’re not stuck
with Podiﬁer—go online and
ﬁnd a better podcast RSS/XML
publisher, such as Potion
Factory’s Podcast Maker ($30,
www.potionfactory.com).
The bottom line. Podcast
Factory is a no-brainer way to get
good audio into your Mac, and
it comes with the software you
need to make sound podcasts.
Quality of the publishing app
aside, it’s a smart bundle at a good
price. However, if you already have a
mic and GarageBand, you may want
to consider the standalone Fast Track
hardware ($129.95), which will save you
50 bucks.—Andrew Tokuda

GOOD NEWS: Great hardware. Plug-and-play
simplicity.
BAD NEWS: Podcast-publishing software needs work.
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The stylish dock for your snippets…

“Elegant and easily accessible, iClip is essential to streamline my workflow.
iClip offers the most efficient way to store copy, code, links, images
and numbers in a graceful hiding dock that doesn’t take up valuable screen
space. I use it countless times a day.”

— Wendi Schneider, www.paintedphoto.com
photographer, designer, iClip user

MacMinute Showtime
Award Winner

See what all the buzz is about at http://inventive.us
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particleIllusion 3.01
POWERHOUSE PARTICLE-ANIMATION APP
Fire, water, wind, smoke,
and otherworldly sci-ﬁ
effects are a click away
from becoming virtually
real in particleIllusion.

I

f your video work involves creating 2D
particle effects, you’d be hard pressed
to ﬁnd a better tool than particleIllusion.
While there are aspects of its interface
that are a bit eccentric, this app makes
juicy, organic eye candy of the ﬁrst order.
particleIllusion is devoted to the
art and science of particle effects. It’s
capable of quickly and easily creating
a wildly diverse array of attractive,
highly customizable animated effects:
ﬁreworks, smoke, highly realistic
explosions, luscious water and bubbles,
lovely sparklers and pixie dust, and
more. Surprisingly, particleIllusion
isn’t an After Effects or Final Cut Pro
plug-in; instead, it’s a standalone app
with speciﬁc features that are difﬁcult
to implement within the constraints of
plug-in architecture.
The overall interface, while a little
nonstandard, is fairly easy to master.
Particle emitters are organized into
libraries; unfortunately, however, the
included libraries in the downloadable
version of the software lack any
meaningful organization, making
COMPANY: wondertouch
CONTACT: 636-225-7861, ext. 1;
www.wondertouch.com
PRICE: $389
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it difﬁcult to quickly ﬁnd a speciﬁc
effect—the libraries delivered on the CDROM are more logically organized. You’ll
quickly notice that the preview pane for
your selected particle effect displays
in real time, providing instant feedback
without any type of rendering pass (à la
Final Cut). This is a tremendous boon for
busy production geeks who hate tapping
their ﬁngers while watching that cursed
spinning beach ball.
Movie effects. Making a particular
(pun intended) movie is straightforward:
Drag an emitter from the library window
onto the main stage, and press the
spacebar to see the effect play instantly.
The somewhat crude timeline allows
you to create interpolated motion for the
emitter, which is especially important
for particle effects that leave trails
and change over time. particleIllusion
can load a QuickTime movie as a
background layer (critical for adding
effects to existing footage) and even
use After Effects motion-tracking data
to lock an effect to a speciﬁc moving
element in a movie, such as ﬁre and

REQUIREMENTS: 800MHz G4, Mac
OS 10.2.8 or later, 256MB RAM, video
card with OpenGL support

smoke contrails for a
rocket. particleIllusion
renders animations with
perfectly accurate alpha
channels (which handle
even the wispiest smoke,
a typically daunting
challenge), crucial for
integrating the app into
a pro-video workﬂow. You
can also place deﬂectors,
blockers, and forces to
make particles go where
you want them to go,
avoid certain areas of
your scene, and behave
in a realistic, believable fashion.
Double-clicking an emitter brings
up a deeper editor for the selected
particle effect, offering options for
subtle customization or dramatically
different variations on a theme. Many of
the effects use grayscale shapes as the
foundation of their look, and importing
your own images delivers a vast array of
personalized particle goodness.
The most important question is, of
course, how good do these effects
look? The answer is “simply delicious.”
Sparklers give off a wonderfully organic
light, and the color effects of some of the
more lavish presets are nothing short
of dazzling. We expect that you’ll see
particleIllusion-created effects playing a
variety of supporting roles in TV shows,
music videos, and motion pictures.
The bottom line. particleIllusion is
a slick, highly addictive tool designed
to create some of the most gorgeous
particle effects you’ll ever see. The app
is an effects dynamo that belongs in the
toolbox of every serious animator and
video artist.—David Biedny

GOOD NEWS: Gorgeous particle and organic effects.
Wicked-fast rendering. Lots of presets.
BAD NEWS: Interface could use some tweaking.
Downloaded emitter libraries lack organization.
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Suitcase Fusion
HANDY FONT-MANAGEMENT TOOL

Why “Fusion”? Because it combines features from Suitcase and Font Reserve.

E

xtensis’ latest salvo in the battle
for font-management supremacy is
Suitcase Fusion, a hybrid that combines
elements from Font Reserve and Suitcase
with a few new features.
Former Suitcase users will feel
immediately comfortable in Suitcase
Fusion; it retains much of Suitcase’s
user interface along with an abundance
of customizable views and viewing
options. Perhaps the biggest under-thehood difference between Suitcase and
Suitcase Fusion is that the latter—like
Font Reserve—provides the option to
store all of your font ﬁles in a structured
and secure ﬁle called the Font Vault,
weeding out corrupt and duplicate fonts
in the process.
Using Suitcase Fusion is much like
using other font managers. First, you
add fonts by clicking the Add button or
dragging font ﬁles,
ON THE
suitcases, or fontDISC containing folders into
Suitcase Fusion
the Sets or Fonts pane.
COMPANY: Extensis
CONTACT: 800-796-9798, www.extensis.com
PRICE: $99.95, $49.95 (upgrade from Suitcase
9, 10, X1, or FontReserve 3)
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After you’ve added all of your fonts, you
can organize them into sets and use the
buttons at the top of the Suitcase Fusion
window to Activate, Deactivate, and
Remove sets or individual fonts. Suitcase
Fusion includes Morrison SoftDesign’s
FontDoctor X, an exceptionally useful
font diagnostic and repair tool. (It’s a
good idea to run FontDoctor X on all of
your font ﬁles before adding them to
Suitcase Fusion.)
Set point. Suitcase Fusion includes a
ton of features for working with font sets.
For example, you can create font sets
for clients, projects, and font classes
(such as Symbol/Pi fonts, Ornamental
fonts, Serif fonts, and so on) that can be
activated and deactivated as needed,
as well as app-speciﬁc sets that open
automatically when you launch a
particular app. Service providers that
temporarily handle client ﬁles can create
ad hoc sets, which ensure that the correct
fonts are used for a client’s job without
affecting the Font Vault or other jobs.

REQUIREMENTS:
1GHz G4, Mac OS 10.3.9
or later, 256MB RAM

Suitcase Fusion also includes plug-ins
for Illustrator CS and CS2, InDesign
CS and CS2, and QuarkXPress 6.x that
automatically activate the required
fonts when you open a document and
deactivate them when you close the
document. The plug-ins all work as
advertised and use Suitcase Fusion’s
Font Sense technology to ensure that
the correct font is used when multiple
versions of a font are available.
Among the useful Font Reserve
features that didn’t make it into Suitcase
Fusion are buttons that let you display
fonts alphabetically, and features for
printing type samples. Also missing: The
previous QuarkXPress, InDesign, and
Illustrator plug-ins’ Make Font Reserve
Set option, which could create a set out
of the fonts used in a document.
A few shortcomings: While the new
Attributes pane is a nice addition (it ﬁnds
fonts based on classiﬁcation, foundry,
style, or user-deﬁnable keywords), the
ﬁve buttons at the top of the pane aren’t
especially intuitive, and their tool tips
display sporadically; you can’t access
the well-written, comprehensive PDF
quick-start and user guides from within
Suitcase Fusion; and the Help menu
includes only a superﬂuous command
for entering your serial number.
Launching Suitcase Fusion on our dual
1GHz G4 took a little over two minutes—
that was with a 450MB Font Vault ﬁle
containing our modest library of 1,300
fonts. Other actions such as activating
a font set, executing the Collect Fonts
For Output command, and automatic
app-speciﬁc font activation were also
occasionally sluggish.
The bottom line. Mac users get
emotional when it comes to font
management; font-related problems
cause headaches and wasted hours. Is
Suitcase Fusion the be-all and end-all of
font-management software? Probably
not for everybody, but so far, it’s doing
the job nicely for us.—John Cruise

GOOD NEWS: Nice interface. Strong features for font
sets, fixing fonts, and precise automatic font activation.
BAD NEWS: Missing useful Font Reserve features.
Few compelling new features. Sometimes sluggish.
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MultiSync 20WMGX2
FEATURE-PACKED LCD DISPLAY

E

ven when it’s turned off, NEC’s
MultiSync 20WMGX 2 looks
impressive. That’s because the screen
on this 20-inch widescreen display is
a deep, shiny black, unlike the matte
black you see on most LCDs. Fortunately,
images look just as good when you turn
the 20WMGX2 on, from any angle—and
we do mean any angle.
Colors on the 20WMGX 2 are accurate
and vibrant, and blacks are rich and
deep. In fact, it might take you a while
to get used to the black; the screen’s so
shiny you can see yourself reﬂected in
it—though we weren’t distracted by it.
The photos we looked at onscreen had
great tonal quality. In fact, images look
livelier on the 20WMGX 2 than on Apple’s
20-inch Cinema Display (
COMPANY: NEC
CONTACT: 866-632-6673,
www.necdisplay.com
PRICE: $799.99

Nov/04, p39). Text is equally sharp
and smooth. Because it’s a widescreen
display with a 1,680-by-1,050-pixel
native resolution, you can watch DVD
movies the way they were meant to be
displayed—and it makes Doom 3 look
even scarier than it already is.
The MultiSync 20WMGX 2 has
DVI-D, VGA, S-Video, component, and
composite-video connectors, and it
comes bundled with both a VGA cable
and DVI-D cable. There’s even a built-in
analog TV tuner (with a remote, natch)
with a picture-in-picture mode so you
can work in OS X while you keep an eye
on Samantha McCall’s pout on General
Hospital off to the side. The onscreen
controls are easy to navigate; a small
joystick-like nub at the bottom of the

REQUIREMENTS:
Mac with video out

An attractive
alternative to
Apple’s Cinema Diplay.

display lets you select the options you
want to modify.
Two 5-watt speakers rest at the base
of the display; their sound quality won’t
turn any heads, but they don’t sound
horrible, either.
The bottom line. The 20WMGX2,
despite its ludicrous name, is one of
the best-looking displays we’ve ever
seen.—Roman Loyola

GOOD NEWS: Excellent image quality. Great controls.
Full of features. Built-in analog TV tuner with remote.
BAD NEWS: Average-sounding speakers. Not SWOP
certified for soft proofs.

iPod Showcase
Orbino Luxury Cases

Case-mate Leather Case

iPod Mounting Solutions

Protect Your Music with a
Premium Form-Fit Leather Case
by Case-mate.

Taking your music with you
is even easier with ProClip!

Buttery-soft Napa leather
surrounds our impact-resistant
plastic shell. An ultra-soft felt
interior secures your iPod. Each
Case-mate case comes with a
full-face screen protector and fully
removable belt clip.

ProClip mounting solutions are
the best way to mount your iPod in
your vehicle. The mount clips on in
seconds without interior damage.
For details on ProClip mounting
solutions for your iPod as well
as your other devices, visit:

www.case-mate.net
866-689-3432

www.proclipusa.com
800-296-3212

The World’s Finest iPod Case.

By Orbino: a collection of very special
cases crafted entirely by hand in Italy
for perfect form and functionality.
Features:
• Patented spring-loaded polished
metal belt clip and desk stand
• Premium Italian leathers
• Hand-stitched in Italy
• Durashield screen and clickwheel
protector
• Connector access
• Available models: video-capable
iPod, iPod nano, and iPod shufﬂe
www.orbino.com
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browseback 1.0.2
SUPPLEMENTARY WEB-HISTORY UTILITY

W

ith browseback, you have a way to
see and search your Web history,
making it easier to recall Web sites you
found useful during your hunting.
Essentially, browseback displays
rows of thumbnails of the pages in
your Web history. Moving your cursor
over one of the thumbnails triggers an
effect reminiscent of Mac OS X’s Dock
magniﬁcation, popping up the page
so you can get in for a closer look.
New pages that you visit appear in
browseback immediately or within a
few seconds, depending on how many
elements a page needs to load.
Click a page, and you can open the
page in your browser, email it to a
friend, view or save it as a PDF, or print
it. There’s also a search function that
COMPANY: SmileOnMyMac
CONTACT: 510-289-4000,
www.smileonmymac.com
PRICE: $29.95

REQUIREMENTS:
Mac OS 10.4 or later

doesn’t just look for
page titles, but also
page contents—very
handy. browseback
supports seven Web
browsers (Camino,
Firefox, Internet
Explorer, Netscape,
Combine Apple’s Dock magniﬁcation with your Web browser’s
OmniWeb, Opera,
history, and you get browseback.
and Safari), but
individual pages, there’s no simple
browseback doesn’t work with some
“clear all pages” option. You can go into
lesser-known browsers such as Shiira.
the app’s preferences and set it to keep
There are a few limitations worth
Web pages for zero days, or you can
mentioning. Files on your hard drive
delete everything in your /Documents
that you open with a Web browser
/browseback folder.
won’t appear in browseback. Also,
The bottom line. browseback
browseback will only catalog the
is a great timesaving tool for Web
opening page of a JavaScript-powered
research.—Roman Loyola
photo album. While you can delete
GOOD NEWS: Cool interface. Doesn’t track entry into secure
Web sites. Searchable records.
BAD NEWS: Doesn’t record file:// history. Only records first
page of a JavaScript sequence.

iPod Showcase
Elite Audio Gear

6i Isolator Earphones deliver
detail, balance, comfort,
and value.

The in-ear secure ﬁt reduces
background noise so you can listen
at safe levels. Hear crisp, clear
music inside your head. Great for
travel and working out. Available
online or at Apple Stores and other
retail locations worldwide.
www.etymotic.com

DecalGirl iPod Gear

PodsPlus Aluminum Case

Protect and Personalize
Your iPod.

DecalGirl’s adhesive-backed vinyl
skins allow you to both protect and
personalize your iPod with hundreds
of hot designs, and they remove
without leaving any nasty goo.
Now offering crystal-clear screen
protectors for even more protection!
Save 10% using the code MACADD.
www.decalgirl.com/ma
866-841-0922

Advertisement

Protect your iPod from
scratches and bumps.

Made of aircraft-grade aluminum
with interior neoprene lining, this
high-quality case is strong and
lightweight. The iPod screen is fully
protected. A removable swivel belt
clip is included.
www.podsplus.com
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because you play as hard as you work

TIPS & TRICKS

Call of
Duty 2
War is hell, and Call of Duty 2 deﬁnitely has some
hellish missions and challenging multiplayer maps.
Keep your head down and follow these tips—it could
mean the difference between a heroic homecoming
and a KIA telegram.
■ When using any sniper riﬂe, hold down Shift to hold
your breath for a steadier shot.
■ Smoke grenades are your best friend. Throw
them to conceal your position, and then rush your
opponent or get closer to a tank. When you have to
make a long run and there’s no cover in sight, toss
two grenades in a series for a larger cloud.
■ In multiplayer mode against human players, smoke
grenades can reveal your position to your enemy.
Instead of using them for cover, use them to
distract and ﬂank your enemy.
■ Explosive grenades blow up about 3.5 seconds
after leaving your hand. You can’t toss an enemy
grenade back at its thrower, but the game’s AI
characters can.—Matt Osborn

Don’t let smoke
get in your eyes.

Minions of Mirth
Premier Edition
FRUGAL AND FUN MMORPG

P

riced right at $29.95 with no monthly
fees, Minions of Mirth offers a roleplaying experience robust enough to
satisfy your jones for a fantasy MMORPG
(that’s “massively multiplayer online
role-playing game” for you noobs).
MoM features multiple races (12)
and classes (16) to choose from, a vast
world to explore, a variety of quests to
complete (which you get from nonplayer characters), and different skills
to learn. What makes MoM stand out
is that you can control a party of six
characters at once, so you can create
a group of adventurers with skill sets
that complement one another. However,
only your main character is represented
onscreen; during battles, your party
members’ attacks are communicated
in text (“Jim thrashes Wild Dog for 15

damage!”). It would
have been more
exciting to actually
see your other party
members, but for
MMORPG vets,
controlling a whole
party is a welcome
twist that breathes
new life into familiar
gameplay.
Players of the original EverQuest will
ﬁnd the graphics and interface familiar—
MoM deﬁnitely lacks the elegance and
sophistication of today’s top MMORPGs.
But the interface works, and the graphics
look good at high detail levels.
The bottom line. MoM is a great
buy for MMORPGers—and no, we can’t
pronounce that, either.—Roman Loyola

Can you guys
spare a sword for a
wandering warrior?
COMPANY: Prairie Games, www.prairiegames.com
PRICE: $29.95
REQUIREMENTS: G4, Mac OS 10.3 or later
GOOD NEWS: Affordable. No monthly fee. You can
host your own game server.
BAD NEWS: Long load times. Dated-looking
graphics.

RATED

GREAT
June 2006
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It’s important to keep your city
folk happy, or they might revolt—
and no, you can’t slip anything
into the water supply.

Sid Meier’s Civilization III:
Complete
ADDICTIVE HISTORICAL STRATEGY GAME

I

TIP

n Sid Meier’s Civilization III: Complete,
you plant the seeds of a new
civilization and guide it turn by turn
toward world domination through brute
force, economics, technology, cultural
inﬂuence, or by fulﬁlling scenario
objectives. Civilization III: Complete has
tons of enhancements and features, but
it’s too bad that it took a while for it to be
released—PC gamers have been playing
Civilization IV for months.
At the outset of the game, you don
the guise of a legendary leader such
as Joan of Arc, Queen Elizabeth, Julius
Caesar, or even Abraham Lincoln (who
looks great as a barbarian). Each
leader has a unique personality, and
the civilizations they lead have special

58

FASTER, MULTIPLAYER!
KILL! KILL!
To make online multiplayer games go
faster, set the game to Simultaneous
Movement. Now everyone must move
at the same time; once the timer
expires, the game plays the moves
out. Try Turnless mode, too.

June 2006

qualities. America, for example, is
industrious and expansionist, so the
workers are fast. Each civilization also
has a special unit it can produce when
it hits a certain time period—Egypt gets
a War Chariot in the Bronze Age, while
the United States gets an F-15 in the
Modern Age. You guide your people from
4,000 B.C. to the era of space travel,
expanding your territory and gathering
resources along the way. There’s more
than one way to win the game: by
crushing your foes in battle, through
the inﬂuence of your culture and your
Wonders (innovations that are unique to
your civilization), by getting elected as
the head nation of the United Nations, or
by being the ﬁrst to reach space.
Civilization III: Complete contains
tons of enhancements, and the two
expansion packs, Play the World and
Conquests (previously only available
for Windows) are seamlessly integrated
into the main game. Intriguing new
historic scenarios based on such
events as the rise of Rome or WWII offer
preset enemies, allies, and objectives.
Complete also offers 15 new tribes

(31 in all), such as the Incans,
Hittites, and Mayans. New
Wonders include the Internet,
which adds a free science lab to
all your cities, and the Knights
Templar, which recruits military
units every few turns. And that
only covers a few of Complete’s
plentiful enhancements.
Multi-player, multi-days.
An online eight-player game
can take several days. Luckily,
you can save mid-game and
return later with your mates. If
you’re disconnected, though,
be sure that the host stops and
saves the game right after the
dropped party leaves, otherwise
the dropped civilization is
automatically destroyed on
the next turn. The old-school
Hotseat mode allows multiple players
to play on one Mac by switching seats
each turn. In Play-By-Email mode, the
ﬁrst player sets up the game, plays his or
her ﬁrst turn, saves it, and then emails
the SAV ﬁle to the next player—and each
player can have a password to ensure
the others don’t cheat.
The in-game graphics use 2D sprites
that look dated, even though the
charisma of the prerendered leader
portraits still shines through. The worldmusic soundtrack sounds like it came
from a bad MIDI-enamored band from
the nineties.
The bottom line. Once you get through
the ﬁrst ﬁve hours—dealing with the
lackluster learn-as-you-go tutorial and
ﬂipping through the manual to ﬁnd out
what the heck you just did—Civilization
III: Complete is addictive.—Matt Osborn
COMPANY: Aspyr, 512-708-8100, www.aspyr.com
PRICE: $49.99
REQUIREMENTS: 500MHz G4, Mac OS 10.3.9 or
later, 256MB RAM, 2GB disk space, Internet and
GameRanger or LAN (for multiplayer)
GOOD NEWS: Even more addictive than previous
versions. Multiplayer modes. Limitless game-mode
customizations.
BAD NEWS: Should have been released a while ago.
Graphics look dated.

RATED

GREAT
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Don’t ﬁre until you
see the whites …
whoops, too late.

Marble madness.

HoppiX
FUN BOARD GAME

H

oppiX is a simple, fun game in
which you jump marbles adjacent
to each other to eliminate them from
a game board. You hop as many times
as you can (setting up strings of hops
worked well for us), and when you
can hop no more, the game ends. The
number of leftover marbles determines
whether you win—come in below or at
the maximum number to declare victory;
go above that number, and you’re a
loser, baby.
We found the single-level Classic
and Classic Plus modes great for quick
play sessions, but if you have more
time to spare, you can try conquering
one of three multiple-level modes:
Radioactive, Smalltime, and Totally
Square. It won’t be easy, though,
because not only do you have to deal
with varying board sizes and marble
counts, but the pesky clock (enabled in
Smalltime and Totally Square), can be
frustratingly tough to beat.
The bottom line. HoppiX is an
engaging lil’ board game that won’t
leave you bored.—Gil Loyola
COMPANY: IllumineX, 800-450-2278,
www.illuminex.com
PRICE: $14.95
REQUIREMENTS: Mac OS 10.1 or later

COMING SOON

Flex Your Napoleon Complex
Imperial Glory takes you to late 18th- and early 19th-century Europe, where your
job is to lead your country (Austria, France, Great Britain, Prussia, or Russia) to
European dominance through the ﬁne art of turn-based strategy. You battle on
land with your country’s artillery and special units, and take to the sea with three
different war vessels and 21 different maritime battlegrounds—or, more properly,
battlewaters.—Roman Loyola
IMPERIAL
GLORY

COMPANY: Feral Interactive, www.feralinteractive.com
AVAILABLE: TBD ■ PRICE: TBD

COMING SOON

Make Your Wet Dreams Come True

Grab your towel and trunks—RollerCoaster Tycoon 3 is getting an expansion
pack, and it’s all about H2O. RollerCoaster Tycoon 3: Soaked doesn’t change the
create-an-amusement-park heart of the game, but it adds all the joys of water
amusements to the mix. Soaked comes with wave pools, waterslides, log rides,
laser water shows (in sync with your own music), tunnels, aquariums, whale
and dolphin
shows, new
roller coasters,
and more. It also
includes new
ride and park
designers for
swimming pools
and waterfalls.
—MO

GOOD NEWS: Simple and fun. Several different
game modes.
BAD NEWS: Higher levels can be aggravatingly
difficult.

RATED

SOLID

Hey, no running
by the pool!
ROLLERCOASTER
TYCOON 3: SOAKED

COMPANY: Aspyr, www.aspyr.com
AVAILABLE: August 2006 ■ PRICE: TBD
June 2006
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because inquiring minds have the right to be inspired
Now you can call up the Google map or
directions to the address from within
Address Book.

TOASTLESS BURNING

MULTIPLE MAPS
Address Book’s mapping feature is cool,
but is there a way to make it use Google
Maps instead of MapQuest?
There’s a nifty plug-in
ON THE
that does exactly
DISC that. Download Brian
Google Maps Plugin
Toth’s Google Maps
Plugin (donationware, on the Disc, www
.briantoth.com/addressbook) and drop
the included ﬁles into either /Library/
Address Book Plug-ins or /Users/user
name/Library/Address Book Plug-ins.

Can I back up my commercial software
CDs without buying Toast or other CDburning software?
You can use Mac OS X’s Disk Utility,
provided you have enough free space
on your hard drive to accommodate a
temporary duplicate of the disc you’re
backing up. Put the disc you want to
copy in your Mac’s optical drive, launch
Disk Utility (/Applications/Utilities),
and highlight the name of your CD in
the list on the left-hand side of the

window. Next, choose File > New > Disk
Image From your CD’s name. In the
resulting dialog, name the disc exactly
as your original disc is named, select
CD/DVD Master from the Image Format
pull-down menu, and click Save. When
your disc image is complete, it’ll appear
in the lower part of Disk Utility’s list;
highlight its name, click the Burn button
at the top of the window, and then
follow the remaining onscreen prompts
to seal the deal.

gets you halfway there. Open the
MIDI ﬁle in QuickTime Pro, select File >
Export, and then select Music To AIFF.
Then drop the converted AIFF ﬁle into
iTunes and convert away.

SQUIDDLY MIDI
In iTunes, is there a way to convert
a MIDI ﬁle into an MP3 ﬁle?
As of version 6.0.2, iTunes lost its prior
ability to convert MIDI ﬁles. Unless or
until Apple ﬁxes iTunes’ MIDI malady,
you need to pick up QuickTime Pro
($29.99, www.apple.com), which only
52
60

August
June
2006
2005

My mouse has extra buttons and
a clickable scroll wheel, but no
conﬁguration software. Can I tweak
the buttons to do my bidding?
You can program almost any USB device
with USB Overdrive ($20, on the Disc,
www.usboverdrive.com), but that’s
probably overkill. System Preferences >
Dashboard & Exposé provides pull-down
menus that let you specify what happens
when you click different mouse buttons.
Certain apps have default shortcuts in
place; for example, in Safari, you can
click any link with
ON THE
your scroll-wheel
DISC button to open the
USB Overdrive
link in a new window.

iMOVIE ANYWHERE

You can back up DVDs from Disk Utility, too.

Sure, I know the way to San Jose ... er,
Cupertino.

BUTTON REASSIGNMENT

My Mac is running out of disk space.
Can I ofﬂoad iMovie projects onto an
external drive and still use them?
iMovie stores projects in your /user
name/Movies folder by default, but
you can designate an alternate location
when you create and save a project. And
as of iMovie 6, projects are completely
self-contained, so you can just drag
a preexisting project from your /user
name/Movies folder to an external drive.

You can stash iMovie projects anywhere.

Welcome to the future, friend. Memory
management was indeed a ritualistic
part of Mac OS 9, but OS X smartly and
dynamically divvies up your RAM for you,
as your apps dictate. In other words, you
don’t need to worry about such things
anymore.

LUNCHTIME LOCKDOWN
Plan B: Downgrade to iTunes 6.0.1.

REMEMBER MALLOC?
I just upgraded from OS 9. How do
I tweak my applications’ memory
allocations in Mac OS X?

How can I lock my iMac during my lunch
break so my sneaky coworkers can’t
mess with it?
Easy—just go to System Preferences >
Security, and check the box labeled
Require Password To Wake This

DIFFICULTY
RATINGS

No whining—
anyone
can do this!

LASER POWER
When I try to burn a CD with Disk Utility,
I get the error message, “The device
failed to calibrate the laser power level
for this media.” What gives?
This error can signify two problems:
one trivial, one major. If you’re lucky,
you’re just using cheap media that your
burner doesn’t like. If you’re less lucky,
your burner may be hosed, and you’ll
need to get it repaired or replaced. First,
try burning at a slower speed from the
Finder; you can specify burn speed in

Speed won’t burn out your burner, but it
may stymie it.

the pull-down menu that appears after
you click Burn. You can set iTunes’
burn speed in iTunes > Preferences >
Advanced > Burning. If lowering the
burn speed doesn’t help, go buy a few
different types of media and try again. If
you still can’t burn, it’s time to visit your
friendly neighborhood Apple Certiﬁed
Technician.

GET PERMISSION
When I try to repair disk permissions,
I get an error saying that Disk Utility
has lost its connection with the diskmanagement tool and can’t continue, and
that I should restart OS X—but restarting
my Mac doesn’t help. Now what?

It’ll take some
effort, but you
can do it.

UNIX UNIVERSITY
UNIX IS EVERYWHERE
Mac OS X is supposed to be all about integration.
So how does the Terminal integrate with other apps?
You already know that you can avoid
<a href=”x-man-page://du”>click
typing long path names by dragging ﬁles
this link to open your Terminal</a>.
and folders directly from the Finder into
If this x-man-page nonsense seems
a Terminal window, right? You can also
dangerous (it’s not), you can disable
launch the Terminal’s Unix manual pages
it along with other oddball URL types
from Safari or another Web browser. For
for opening iChat, iCal, Keynote, and
example, type x-man-page://du in
other apps you’d never need to launch
your browser’s URL ﬁeld, and the Terminal
from a Web browser. Just download
will open with the manual pages for du,
RCDefaultApp (free, on the Disc, www
Unix’s disk-usage utility. You can embed
.rubicode.com/Software/RCDefaultApp),
the x-man-page link in a Web page by
and double-click RCDefaultApp.prefPane
adding the following to your HTML code:
on the disk image to install it. Open
System Preferences > Default Apps, click
the URL tab, scroll to the bottom of the
list, highlight x-manON THE
page, and select
DISC Disable from the pullRCDefaultApp
down menu.
Just in case you ever want to prevent folks
from launching Unreal Tournament from a
Web browser.

It sounds like you’re dealing with a
speciﬁc permissions problem that only
presents itself when you have both
iTunes 6.0.2 and Mac OS 10.3.9. If you
don’t want to upgrade iTunes or make
the jump to Tiger, there is a workaround:
Drag iTunes out of the Applications
folder and onto the desktop, run Disk
Utility, and repair permissions. You
can then put iTunes back into the
Applications folder.

Computer From Sleep Or Screen Saver.
Don’t forget to use System Preferences >
Desktop & Screen Saver to set up your
screen saver’s behavior.

GET MORE INFO
I use Get Info (File > Get Info) all the
time. Is there a way to get multiple
ﬁles’ info in a single Get Info window?
Yup. Highlight a ﬁle or six, and press
Command-Option-I to open a Multiple
Item Info window that contains info
about all of the selected items. Bonus:
You can select more ﬁles, and the
Multiple Item Info window stays open
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This stuff’s
for the pros.

DVD IN DISGUISE
I love my iPod mini and my Mac mini,
but what in tarnation is a miniDVD?
It may sound like a miniDVD is a smallersize DVD, but it’s actually a CD that
contains DVD-movie content—though
due to the capacity of a CD, a miniDVD
can only hold about 15 minutes of video.
You can create your own miniDVD with
Toast Titanium ($99.95, www.roxio
.com); just burn a DVD as you normally
would, only when it asks for a blank
DVD, insert a blank CD instead. The
resulting miniDVD will play just ﬁne
on your Mac using Apple’s DVD Player
app (as long as you launch DVD Player
manually), but many standalone DVD
players don’t acknowledge miniDVDs.
Buz Zoller is a graphic designer living
in Florida. He has been a devoted Mac
user for over 10 years and has worked for
both Apple and Power Computing.

This is Get Info’s bulk mode.

and updates itself. Use this to change
your ﬁles’ properties en masse.

Submit

technical questions
or helpful tips directly
via email (askus@macaddict.com) or c/o
MacAddict, 4000 Shoreline Ct., Ste. 400,
South San Francisco, CA 94080.
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fix pics with Photoshop Elements 4

Fix Pics with Photoshop Elements 4
by Cathy Lu

OPTIONS BAR Changes depending
on which tool is currently selected.

TOOLBOX

Select
cropping,
retouching,
navigation,
type, and
selection
tools here.

RED EYE REMOVAL

Remove demon
eyes with Elements’
automatic and
manual controls.

HOW-TO
WINDOW

Quickly look
up tutorials
and basic
editing tips.

See “Red-Eye
Redux,” p63.

STYLES AND
EFFECTS
WINDOW

STRAIGHTEN
TOOL If you

Select effects,
ﬁlters, and
layer styles.

have an offkilter photo,
use this to
set it straight.

SKIN TONES
OFF? Adjust

See “Set
Your Photo
Straight,” p63.

Color For Skin
Tone can help.

See “Fix Skin
Tones,” p63.

WHAT YOU NEED
Photoshop Elements 4 ($79.99 download,
$89.99 CD-ROM, www.adobe.com)
Mac OS 10.3 or later
Pictures that need help

H

Replace a Color
Sometimes you want to tame the hue of an object so that it doesn’t dominate a photo.
Other times you just don’t like the color of the sweater your spouse was wearing that day.
Here’s how to hijack one color and replace it with another—without wreaking havoc on the
whole scene.

Make Your Selection

First, select the object that you want to alter. To do that, open your photo, choose
the Magic Selection Brush Tool (its icon looks like a red-tipped brush), and start
scribbling in the area you want to select. When you’re done, release the mouse button, and
let Elements generate your selection. You can change the size of the brush or the color that
it draws in (by default, red) via the Options Bar. If you don’t
get your entire selection the ﬁrst time, just keep brushing
We drew all over our door in
over the missed areas to add them to your selection.
red marker to make a selection.
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lock, unlock, and change the
order or opacity of layers.

olding the camera crooked. Forgetting to activate the red-eyereduction setting. Letting dad wear his key lime shirt for the family
photo. We all make mistakes when it comes to photography. Here’s
how to use Photoshop Elements 4 and its new tools to clean red eyes,
straighten crooked buildings, and adjust squalid skin tones—all in a few mouse
clicks. Want more? We’ll also show you how to perform complex photo-editing
magic, such as color-shifting dad’s shirt or compositing the family pet into a
favorite image.

New Technique:

1

LAYERS WINDOW Show, hide,
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New Tools
Set Your Photo Straight
We admit it: Sometimes we like to get a little artsy with our photography by angling our pics. But
that technique doesn’t always work out, and photos wind up looking like we were in stumblebum
mode instead. Fortunately, Photoshop Elements 4 provides a quick ﬁx for straightening crooked
photos. Open your image, and click the Straighten Tool (its icon looks like straight box over a
crooked box). In the Options Bar, change the Canvas Options pop-up menu to Crop To Remove
Background—this keeps your picture in a perfect rectangle by slicing off the sides after rotation
(note, though, that your picture dimensions will shrink). Draw a line to
represent a new horizon line (in our example photo, we used the top of
The Straighten Tool can
the stone wall as a guide). Presto! Elements straightens your picture.
upright your images.

Red-Eye Redux

Fix Skin Tones

Yes, most digicams have red-eye-reduction settings. And
yes, we forget to use ’em. Luckily, Elements’ new Auto Red
Eye command automatically searches out and corrects the
problem. Open your infected image, and select the Red Eye
Removal Tool (the red eye icon). In the Options Bar, tweak
the Pupil Size and Darken Amount settings, and then click
the Auto button.
If that doesn’t get
the red out (the
tool isn’t always
successful right
away), manually
click next to each
reddened eye.
Fair enough.

Sometimes skin tones just end up looking off, whether the
lighting conditions were funky or you didn’t have your camera
set correctly—that’s where Elements 4’s automatic skintone adjuster comes in. To correct unnatural-looking skin
colors, select Enhance >
Adjust Color > Adjust Color
For Skin Tone; while the
resulting dialog is still open,
click your subject’s skin.
Elements automatically
adjusts all the colors in
your picture. If you don’t
like the results, play around
with the Tan, Blush, and
Temperature sliders.

The Red Eye
Removal Tool
takes care of any
Luciferian pupils.

2

Tweak Your Selection

Our initial pass with the Magic
Selection Brush Tool ended
up getting everything on our ancient
door—even the knob and decorative
wrought-iron swirls. To deselect areas
you didn’t intend to grab, select the
Indicate Background tool (brush with
minus sign) from the Options Bar
and mark areas you don’t want (they
appear blue by default). You may
have to go back and forth between
the Indicate Background and Indicate
Foreground tools to get everything
The Indicate Background
right. (Indicate Foreground is the
tool excluded all of the
brush you used in the previous step.) black areas from our door.

Our subject started out
looking unnaturally orange
(inset), but Elements restored
her skin tone to normal.

3

Change the Color

Once you’ve perfected
your selection, go
to Enhance > Adjust Color >
Adjust Hue/Saturation. Using
the Hue slider, you can play
around with colors. You can
also tweak the Saturation
and Lightness. When you’re
happy with the results, click
OK, and save your newly
recolored image.
If only it were this
easy to paint a
door in real life.
June 2006
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fix pics with Photoshop Elements 4

New Technique:

Create a Composite
It’s not likely that you’re going to take your cat with you on your European vacation; but if you want to see what le chat would look
like in front of la Tour Eiffel, you can—the pros call it compositing.

1

Extract the Image

2

Fix Your Selection

Open the image containing the object you wish to extract.
Here, we’re going to move this cat we found in Rome
to another locale. Go to Image > Magic Extractor, select the
Foreground Brush Tool (the icon looks like a marker with a plus
sign), and start clicking within the area you want to extract (aka
the cat). When you’re done, switch to the Background Brush Tool
(marker with minus sign) and click the areas you want to exclude.
Click Preview, and wait while Elements generates the extraction.

Once Elements extracts your object, you’ll likely have to do
some touch-ups. In the same Magic Extractor dialog, use
the Add To Selection tool (brush with dotted circle) and move your
brush over any parts of your object that Elements missed. Use the
Remove From Selection tool (eraser with dotted circle) to erase any
excess gunk that you don’t want in your picture. For more-precise
control, adjust the Brush Size. When you’re done, click Defringe to
minimize the fringing effect you get between the background and
foreground. Click OK to produce your extracted object.

The red marks show the area you want to extract; the blue is what
you want to exclude.

You’ll have to use the Add To Selection and Remove From Selection
tools to tweak your object.

3

4

Add Your Object

Now it’s time to move your cat to its new home. Select
your object (Command-A), and copy it to the clipboard
(Command-C). Open the image you want to use for your new
background (in our case, an old church in Scotland), and paste
in the object (Command-V). Use the Move Tool (pointer with
cross arrows) to position your object where you want it, making
sure that Auto
Select Layer and
Show Bounding
Box are checked in
the Options Bar. To
scale the object,
press Shift while
adjusting the size of
the bounding box.
Click the checkmark
in the Options Bar
when you’re happy
with your object’s
size and position.
Once you paste
your object in
place, you’ll
have to scale it
to the right size.
64
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Add Details

Our Roman cat looks a little out of place here in Scotland,
so we’re going to add a shadow. To do that, copy and paste
another version of your object into the picture, scale it to about the
size of the original (or slightly smaller), and click the checkmark
in the Options Bar to accept it. Go to the Hue/Saturation dialog
(Enhance > Adjust Color > Adjust Hue/Saturation) and move the
Lightness slider to the
left until your object
becomes a shadow of
its former self. Next,
select Filter > Blur >
Gaussian Blur, and
play around with the
Radius setting until
your shadow looks
realistic. Finally,
using the angles of
the other shadows
in your picture as
reference, move your
shadow into position.
By tweaking the
Lightness settings and
adding a blur, you can
create a shadow.

Cathy Lu is a former MacAddict editor and now a freelance writer living in Seattle.
She likes to make all her pictures look sunny to compensate for the weather.
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prep your iPod for Armageddon

Prep Your iPod for Armageddon
by Niko Coucouvanis
WHAT YOU NEED
Any iPod (preferably one not yet scratched)
At least a foot of 3M Scotchgard 8mil Paint Protection
Film, 12-inch width ($6.50 per foot, www.xpel.com/
products/bulk.asp)
Liquid dishwashing soap and water
X-Acto knife or similar sharp blade
Credit card or similar impromptu squeegee
iPod nano cover template (free, on the Disc,
www.macaddict.com/podplate)

E

When the
end times
arrive, at
least your
iPod will
survive.

veryone knows how scratch-prone iPods are—nanos
in particular. The solution: Encase your precious ’Pod
in 8mil-thick polypropylethylene—aka 3M Scotchgard
Paint Protection Film. Got more cash than free time?
You can buy a similar invisibleShield, custom cut for any iPod,
from ShieldZone ($19.95 to $24.95, www
.shieldzone.com). But if you follow our
ON THE
DISC directions, you’ll have enough material (and
know-how) to protect your cell phone, PDA,
iPod nano template
(nanotemplate.jpg)
PSP, and other scratchables.

1

Get the Goods

Shortly after we tried (and fell in love with) ShieldZone’s
invisibleShield, we ﬁgured there must be a way to make
our own—for other iPods, digital-camera LCDs, our Treo, PSP, and
even the car. (People use thicker grades of Scotchgard to protect
their fancy sports cars and even helicopter blades.) We tracked
down one vendor who sells 3M’s Paint Protection Film in as small
as 1-by-1-foot pieces, enough to cover any iPod twice if you’re
careful. Order at least a foot of X-PEL’s 12-inches-wide 8mil Paint
Protection Film ($6.50 per foot, www.xpel.com/products/bulk
.asp). You may want to get more for your friends’ iPods, your car,
your little brother, or anything else you want to encapsulate.

Nab our nano
template from
the Disc or www
.macaddict.com/
podplate.
66

June 2006

This how-to involves intentionally applying water
and harsh abrasives to the surface of your iPod—so
do we need to tell you to be very, very careful? Well,
we’re gonna anyway: Be very, very careful.

2

Trim the Template

Grab our nano template (from the Disc or www.macaddict
.com/podplate), open it in Preview (/Applications), and
print it on plain 8.5-by-11-inch paper (in the Print dialog, uncheck
Scale To Fit if you need to). Cut along the outer lines to trim the
template, then trace the pattern onto the Scotchgard with a ballpoint pen. Lay the Scotchgard on a phone book or other surface
that you can cut into and use a new X-Acto blade to carefully cut
the pattern out of the Scotchgard. Take your time and use a ruler
or other hard edge for a guide on the straight cuts; we found it
nearly impossible to cut a smooth circle around the clickwheel
and made a series of little cuts instead—lots of little cuts.

Our template is only
a guide—modify it
to suit your tastes
(or other iPods).
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3

Scrub a Dub, Redub

Thoroughly clean the iPod with a microﬁber cloth,
chamois, or other soft cloth. Stash the iPod somewhere
clean while you prepare a solution of 1/2 cup of water and three
drops of liquid dishwashing soap. Now thoroughly wash your
hands—if you’re a mechanic or gardener, use a scrub brush to
get all the gunk out of your
ﬁngerprints. Scotchgard
can suck grime out of the
cleanest-looking ﬁngers,
so wash again—and still be
careful handling the ﬁlm.
Clean your ’Pod ﬁrst, then
wash your hands—twice.

4

Slap It On, Jack

Wet your ﬁngertips in the soapy water and carefully
peel the backing off of the cut ﬁlm—try to keep your
ﬁngers off the sticky side, and avoid stretching the ﬁlm. Dip the
entire piece in the soapy water and hold it up for a moment to
let excess water drip off while you ponder this Zen riddle: More
water makes positioning the ﬁlm easier, but also increases the
risk of water damage inside the iPod. If you fear some water got
in, let the iPod sit for a day to dry out before you turn it on. With
minimal soapy water between the ﬁlm and the iPod, you can
easily slide the ﬁlm around and position it just right. Inspect all
of the covered surfaces for air bubbles, and use your thumbs
to press excess water toward the edges—this will help afﬁx the
ﬁlm in place before you apply the credit-card squeegee, which
tends to grab and move the ﬁlm if it’s too wet. Once the ﬁlm
sticks tightly enough to the iPod that you can’t slide it out of
place using your thumb, use a credit card to squeegee out the
remaining water—use ﬁrm, even pressure, and squeegeeistically
scrape out toward the ﬁlm’s
edges. Finally, massage the
covering a little more with
your thumbs to smooth out
any remaining unevenness.
Do your best to keep water
out of your clickwheel,
dock, and earbud ports.

5

Abort! Abort!

Air bubbles (and ﬁnger grime) are the bane of
Scotchgard. If you don’t remove an air bubble before
the water dries, you’ll never get it out. If you see an air bubble,
get a drop of water under the ﬁlm if you can, and gently peel the
ﬁlm back (careful not to stretch it!), drip on some more water,
and reapply the ﬁlm. If you discover an air bubble after the ﬁlm
dries, try poking it with the
tip of your X-Acto blade to
release the trapped air, then
ﬂatten the busted bubble
with your thumb.
It’s good to have
some extra Scotchgard.

Clean a Severely
Scratched iPod
by Niko Coucouvanis
WHAT YOU NEED
Badly scratched iPod
Brasso ($4.29, www
.amazon.com)

U

nless your iPod is still
in its box, it’s probably
got a scratch or 12
that you’d rather not preserve
forever beneath Scotchgard.
We Brasso-buffed the heck
Several companies sell acrylic
out of this scratched iPod
polish and scratch removers
with excellent results.
speciﬁcally for iPods, but to
remove really (really) bad scratches, you’ll need to step up to
an industrial-strength solution: Brasso brass polisher. Most of
the acrylic de-scratchers ﬁll in scratches with a clear compound,
but Brasso actually grinds down the iPod’s surface to remove
scratches. Needless to say, use extreme caution.

1

A Little Dab’ll Do Ya

Use a super-soft cloth, such as one that came with your
eyeglasses or camera lens; we found several sizes of
chamois ($5.44 to $24.99) and even a microﬁber cloth ($4.99)
at our local Kragen Auto store. Whatever you do, don’t use a
paper towel or T-shirt. Fold the cloth over on itself a couple
of times for padding, and smear a small amount of Brasso
on the cloth. Rub the iPod in a circular
motion using extremely light pressure.
We rubbed our most beat-up iPod for
well over an hour before the scratches
disappeared. Try to keep Brasso out of
the gaps around the clickwheel, dock
connector, and headphone oriﬁces.
Tip: Take little dabs from a spoonful of Brasso.

2

Buff ’Er? I Barely Know ’Er!

When you think the scratches might be gone, stop
rubbing—you can always apply more Brasso if scratches
remain. Use a clean part of the rubbing cloth to wipe off any
Brasso residue, and then use another clean part of the cloth
to further buff the iPod without abrasion. If you’re patient, the
results can be quite impressive. More
importantly, if you’re not patient, and you
stop too soon or don’t completely buff
off the Brasso, your iPod might come out
looking worse than when you started. We
warned ya.
Don’t skimp on the polishing cloth—you’ll
want to ﬁnish up with a clean patch.
June 2006
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use iWeb with your own Web host

Use iWeb with Your Own Web Host
by Niko Coucouvanis
WHAT YOU NEED
iWeb ($79, part of iLife ’06, www.apple.com)
Cyberduck (free, on the Disc, http://cyberduck.ch) or other
FTP client

ON THE

DISC
Cyberduck

O

h, iWeb: How we hate to love ye. Apple’s visual Web-design tool has its
limitations, especially if you don’t host your site on Apple’s .Mac servers.
But we know some tricks that make iWeb usable with your garden-variety
hosted Web space, and because we like you, we’re sharing.

1

Screw You, .Mac, I’m Going Home

The ﬁrst step’s a gimme: After creating your site in iWeb,
select File > Publish To A Folder; in the resulting dialog,
create a new folder called iwebber, and click Save. Afer that,
uploading an iWeb site to your Web host is simple: Just launch
Cyberduck (any FTP client will do, but Cyberduck’s syncing
utility comes in handy in step 2), connect to your Web host’s
FTP server (if
you don’t know
how, check with
your ISP), and
drag your site
folder (iwebber)
from the Finder
into Cyberduck’s
browser. If doing
this chokes the
’duck, then skip
ahead to step 3.
Quack, quack, quack! We don’t need .Mac!

3

Spatial Cases
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The next time you update your site in iWeb and publish
it to a folder on your Mac, launch Cyberduck, connect
to your host, click the remote iwebber directory in Cyberduck,
select File > Synchronize, and then select your local iwebber
folder. The best syncing method, Mirror Files, compares the
modiﬁcation dates on local and remote ﬁles and replaces
whichever is older. But iWeb updates every ﬁle’s modiﬁcation
date on each publish, so Mirror Files wastefully uploads the
entire site every time. Upload Files Missing On The Remote
Server is more efﬁcient, but you’ll have to remember to manually
upload dependant ﬁles such as
the blog index, or sync only your
Blogs folders, for example, when
you publish a new blog post.
If you have bandwidth to burn,
Mirror Files re-uploads the
whole burrito.

4

RSS Interruptus

iWeb automatically creates an RSS feed and places a
Subscribe To RSS link on your blog pages, but the link
won’t work on non-.Mac servers unless you follow two rules.
First, keep your site ﬁles in a subdirectory (such as iwebber)
rather than in your main Web directory. Second, iWeb refers to
your site as Site (internally and in the Site Organizer) by default.
You’re free to change the site name at any time by clicking the
site name in iWeb’s Site Organizer, pressing Return, and typing
a new name. When you publish the site, iWeb will use your site’s
name in the directory structure, so use a name like iwebber
(short and free of spaces), and include it when iWeb’s Publish
dialog tells you to
enter your site’s URL,
like so: http://www
.coucouvanis.com/
iwebber.
Correctly naming your
site ensures that the
RSS feed will work.

Sorry, but Niko Coucouvanis refuses to show you
how to add a hit counter—those are so 1998.

Another dirty little iWeb secret is that pages or folders
with a space or other nonstandard character (#%@&*?!)
in the name work ﬁne on .Mac sites, but the special-character
encoding (%20 in place of a space, for example) monkeywrenches many servers. Avoid this mix-up by removing spaces
or odd characters from all of your page names in iWeb’s Site
Organizer; click a page’s name, press Return to make the name
editable, and then get crafty with interCaps and under_scores.
The nav links will
update to match
your new naming.
The same naming
rules apply to
image ﬁles, so
check the titles
of any images
you plan on using
before you place
them on your
.Mac can handle spaces and nonstandard
iWeb page.
characters, but your server probably can’t.

2

Sync or Swim
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www.macsales.com • 800.275.4576
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iBook G3/G4 from $109.99

Sonnet Presto 10/100/1000 Gigabit Ethernet PCI $85.99

A
fu

Is your Mac forgetting what time it is? OWC PRAM batteries starting at $4.99

Wireless Mouse

MA_06-06

new_ma_0606_spreads.indd 2-3

m

Logitech Cordless ‘Click’ Optical Mouse for USB SPECIAL $15.99

Rain Design i360°

The OWC LSPs are precision cut, glove soft leather protectors that prevent potentially
permanent marks which can occur from the trackpad and keyboard while your laptop is closed.

OS

PRAM Batteries

Laptop Screen Protectors

PowerBook G4 17" $17.99; PowerBook G4 15" $17.95
PowerBook G3 15" $14.99; iBook/PowerBook G4 12" $13.95

Lif

S

The Latest Enhancements
Stops
marks!
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Network Adapters

Call or Visit macsales.com/NewerTech
Protect your screen! There’s an OWC Laptop
Screen Protector (LSP) product for your Mac.

Solutions include all cables, EMC
Retrospect Backup, Intech HD Speedtools
and are preformatted with free bonus
software loaded all ready to plug and play
your PowerMac, PowerBook, iMac, iBook, or eMac too.

A Turntable for your iMac G5 17"and 20" $39.00

Eye candies for
your iMac. Six
to choose from.
6.25"

'Top Product'
Power Switch

OW
up

G
G

OWC Mercury On-the-Go Portable
40GB to 160GB from $109.99

See the full line of OWC FireWire solutions, as well
as solutions by LaCie, EZ Quest, SmartDisk, and
Wiebetech online at macsales.com/FireWire

1
2
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Village Tronic VTBook
Add another CRT or Flat Panel Display to your Powerbook $246.99
2.50"

iLugger iMac cases

for the iMac G5 or for Mac mini and/or up to 20” LCD Display
5 color combinations starting at $99.95

www.macsales.com

Left

1.75"

ols

lay
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www.macsales.com

SuperDrive Your Mac From
Only $52.99!
Make Music, Movies & More! Add a Fast
SuperDrive to your Mac to Burn CDs,
DVDs, even 8.5GB Dual Layer DVDs.

Maximize your Mac
www.MacSales.com

Not sure what upgrade is best
for your computer?

Visit:
macsales.com/MyOWC

Speed it up as high as G4/2.0GHz or
Dual 1.8GHz!

A custom shopping experience to make
your Mac a better Mac.

OWC Stocks the full line of G3 & G4 Processorupgrades by these leading manufacturers:

G4 Single Upgrades from $159.00; G4/1.6GHz only $239.00
G4 Dual/1.6GHz from $449.00; Dual 1.8GHz from $595.00
G4 Upgrades for PowerMac G3s, PowerMac G4s, Cube G4, PowerBook G3s –
Even Legacy PowerMac 7200-9600 Models!

30 Day
Money-Back
on NewerTech
and OWC brand
upgrades!

Upgrade Your Memory & Save Hard Drives

Bulk up your computer by giving it higher
capacity to perform for your needs.

Make your computer faster for less with Other World Computing. Memory is the most
inexpensive way to maximize your Mac. From min to
the Max - OWC has the right Memory for your Apple. For PowerMac G5 and

Hard Drive Controllers

iMac G5 Models:

For NEW 2006 MacBook Pro,
iMac, & Mac mini Intel models:

Hard Disk Controller Cards

512MB DIMM from $42.99
1.0GB DIMM from $87.99
1.0GB Pair (512x2) from $83.99
2.0GB Pair (1GBx2) from $175.00
2.0GB DIMM from $239.00
4.0GB Pair (2GBx2) from $459.00

PC5300 DDR2 667MHz 200 Pin
512MB Modules only $59.99
1.0GB Modules only $119.99
2.0GB Set only $239.00

For PowerBook 12/15/17;
iBook G3/G4s:

For PowerMac G4, iMac G4,
eMac G4, Mac mini:

512MB Modules from $49.00
1GB Modules from $115.99
2GB Sets from $229.00

Lifetime Advance Replacement Warranty.

256MB from $25.00
512MB from $49.00
1GB from $89.99

Give us a call or check out our
website. Our compatibility
guide will show just what
options are right to make your
Power Mac, PowerBook, iMac,
etc - a Faster Mac today!
Call 800.275.4576
Visit macsales.com/faster

Acard 2-Channel PCI SATA $59.99
Serial ATA 4-Channel PCI-M $79.95
Tempo ATA & SATA Mac PCI Controllers
Tempo Trio FireWire/USB2/ATA-133 all in
one PCI $149.00

FirmTek

4-Channel SATA Controllers
from $119.95

SATA Internal Mounting System
Sonnet G5 Jive, add 3 SATA HDs to
PowerMac G5 $95.00

Internal Hard Drives

For iMacs, eMacs & PowerMacs
3.5" Plug & Play 40GB to 500GB from $47.99
250GB Super Value $99.95
For PowerBooks, iBooks & Mac mini
2.5" 40GB to 160GB from $77.99
100GB 7200RPM NoteBook Performance $219.99

SATA Enclosures
OWC Mercury Elite SATA RAID Solutions Perfect for
Mass Storage or RAID. Cables included. 1 Year OWC
Warranty. Starting From $79.95

FirmTek

Dual-Bay Hot Swap External Serial ATA Enclosure with
SATA PCI Controller Card $257.95
Sonnet Fusion 4-Bay SATA Kit $549.00

Not sure what your Mac takes?
Buy with Confidence, call or use our online guides.

macsales.com/harddrives

iPod Replacement Batteries

Software
Apple OS X ‘Tiger’ $99.00
full retail box version

Pay less. Get more. Surf faster!

OS X 10.2, 10.3 from $17.99

iPod Replacement Battery Kits

Easy to Install, Tools Included + Online Installation
Videos. Get up to 78% more capacity & 20+ Hours Runtime!

macsales.com/osx

Apple iLife '06
Make the most out of
your digital life. Share
the magic of your
everyday with
NEW!
iLife ’06. Only
iLife '06
$79.00

$79.00

iPod Batteries for nearly every Apple iPod
Starting From $14.99
Not comfortable opening your iPod?

For $39 + the cost of the battery, OWC installs it for you - iPod
shipping Box and FedEx Overnight covered to and from!
macsales.com/iPodinstall

OWC’s full line of iPod Batteries, Accessories, and
more online at macsales.com/iPod

Mac-Only
Internet

$

per month!

High-Speed Nationwide
Dial-up and DSL Services
Toll-Free Tech Support &
More from Mac Experts
Visit FasterMac.net or call toll free
800-869-9152 to learn more or to
sign up.

Prices, specifications and availability are subject to change without notice. Items returned within 30 days may be subject to a restocking fee.
No return will be accepted without Return Merchandise Authorization number.

Right
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Other World Computing
1004 Courtaulds Dr., Woodstock, IL 60098

4/5/06 4:54:10 PM

Adobe®
Creative Suite 2

Wacom®
Intuos3 6x11”

Quark®
QuarkXpress 6.5

Alias®

Order Today!

Only! $319.95

Only! $189.95

Only! $389.95

Save! 67%

Design with the Best!

Save! $50

Create Digital Artwork!

Save! $756

Maya 7 Unlimited
Save! 85%

Make Amazing Projects!

Become a 3D Animator!

We carry thousands of industry-leading software and hardware products at huge discounts for students, teachers and schools. These special prices are
ONLY for the academic community. And our prices are typically $10-$20 lower than most college bookstores! Call or visit us online today and start saving!

Adobe®
Acrobat Pro 7............Save 69%
Photoshop CS 2.........Save 52%
Dreamweaver 8.........Save 53%
Studio 8 ....................Save 71%

FileMaker®
FileMaker Pro 8 ..................$149
Corel®
Painter IX.5...........................$95
CorelDRAW Graphics Suite X3 ...$95

M-Audio®
Ableton Live 5 ....................$249
Pro Tools 7 M-Powered ......$149
Microsoft®
Office 2004 Student/Teacher ....$139

We carry many of the products reviewed in this magazine!
Softpress Freeway 4 Pro ................$179 Kodak EasyShare One ....................$449
M-Audio Podcast Factory...............$139 Epson PowerLite 76c......................$949
Sorenson Squeeze Compression Suite..$199 Pantone huey ...................................$69

NewTek®
LightWave 3D 8.5 .................$195
Sibelius®
Sibelius 4.................................$239
Auralia 2.1.................................$89

Hey Parents!
“You are eligible to buy for your
students at home or away at school.”

Give us a call anytime! 1-800-294-4035

Mac Shop JUNE/06
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FAMILY HISTORY - GENEALOGY

REUNION 8
®

Reunion 8 is the perfect tool to
organize your family history. Plenty of
room for names, dates, places, stories,
notes, tidbits, and
sources. Include
all your favorite
pictures, sounds,
and home movies.
Automatically
build multimedia
web pages to
share your family
history on the
Internet! Print large, colorful tree
charts, timeline charts, and fan charts
for family reunions. Fun
and educational for the
whole family. Reunion 8
takes advantage of OS X
and includes over
100 new features
and enhancements!

Leister Productions

web site/demo: www.LeisterPro.com
e-mail: info@LeisterPro.com

To order, call...

MacConnection 800-800-2222
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POWER YOUR iPod ANYWHERE!
Finally, four different power supplies in one—so your iPod never runs
out of power! The iSuperchargerTM charges and runs your iPod at
home, at your computer, in your car or on the go - anywhere! Charge
your ipod from four different sources: car outlet, 9V battery, AC wall
outlet, and USB port. Compact and sleek (just 1.9 w x 5.75 d), its
connections and ports retract for ultimate portability. Works with iPod,
iPod Mini, iPod Photo, iPod Special Edition, iPod Nano and more.
Just $ 39.95 plus s & h. Order online at
www.iPodsupercharger.com/9803

iPod is a registered trademark of Apple Computer, Inc.
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We’ve got your back.
Thousands of parts and accessories for your Powerbook

formerly PB FixIt. New name, same company
do-it-yourself Powerbook & iBook parts
free online step-by-step Fixit Guides
thousands of parts and upgrades

iFixit.com

Mac Shop JUNE/06
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Interested in advertising in the
iPod Showcase?

MacAddict 3.5˝ X 2.3˝

DATA RECOVERY: 800-440-1904

7 great reasons to choose DriveSavers:
Fast, advanced, proprietary techniques.
All operating systems; Mac, Windows, OS/2,
Netware and UNIX.
� All storage devices including SAN, RAID
and NAS systems.
� Instantly retrieve recovered data
with DataExpress™.
� Recommended and certified by all
hard drive manufacturers.
� Government Contracts
“Restoring Data
� Featured on MacAddict,MacWorld,
and Peace of Mind
CNN, BBC and others.
Since 1985”
�
�

“We Can Save It!”

Visit DriveSavers at www.drivesavers.com

©2006 DRIVESAVERS, INC. 400 BEL MARIN KEYS BLVD., NOVATO, CA 94949 INTL: 415-382-2000
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Contact Larry Presser
(646) 723 5459
lpresser@macaddict.com

Mac Shop JUNE/06
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tell us how you really feel

LETTERS

PARANOID MUCH?

FISH STORY

Rest assured, Mr. Bird, that
we won’t be changing the
name of the magazine to
MackerelAddict any time
soon.—Max

As a retired English teacher
and a life-long ﬁsherman,
I thought I had seen it all,
but Doug Martin surprised
even me—he drew a visual
mixed metaphor (Shut
Down, Apr/06, p80)! The
printed description refers
to spin ﬁshing: Trilene
XL, iPod nano lure, Belkin
iSpinner, spinnerbait, spoon,
crankbait, jig skirts, rattle
tube. And yet the guy in the
drawing is clearly ﬂy ﬁshing.
The vest, rod, reel, and line
are obviously ﬂy-ﬁshing
tools. (I will not mention the
fact that the line should be
coming off the front of the
reel spool instead of the
rear.) The English teacher, ﬂy
ﬁsherman, spin ﬁsherman,
and Mac user in me all
objected to this outrage.
—Charles E. Bird

SHENANIGANS!
On page 52 of your Apr/06
issue, you reviewed a OneButton Mouse (
)
from Apple. I looked at it in
disbelief—the photo was
of a gazillion-years-old
mouse. Then it occurred to
me—you’re running a contest
to see who’s the ﬁrst to point
out the fake article. And no
mention of the contest either,
how subtle!—Barbara Robins
Sorry Barb, there’s no
contest. On a completely
unrelated note, did you know
that the byline on that review,
Nisan Budala, is Turkish for
“April Fool”? (We won’t tell
you what Niko Coucouvanis
means in Greek. It would
blow your mind.)—Max

iFRYDADDY
The MagSafe connector on
the new MacBook Pro is cool,
but what part of it was Steve
Jobs talking about when he
said that Apple was patenting
it? The deep fryer I bought
two years ago has this same
breakaway feature on its
power cord.—Denis

Something’s ﬁshy here...

Survey
Says

20%

n

21%

35%

so
me
ti
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Scene from an upcoming
episode of CSI: Cupertino.

Anyone who’s recently
bought a fondue pot is
probably familiar with the
feature, too, since it was
introduced as an appliance
safety standard in 2001.
Apple’s is the ﬁrst notebook
implementation, so maybe
that’s what Steve was talking
about. Or maybe he just
hasn’t bought a fondue pot
since 1970.—Max

STUPID iPOD TRICKS
Here’s a photo for one of your
monthly caption contests.
You can see more video iPod
tricks at http://web.mac
.com/dickbuist/iWeb/Site/
iPod%20Video%20Tricks
.html.—Dick Buist
That’s just too creepy to pass
up. Consider it contested
(see “Win!”, p79).—Max

WHAT’S YOUR FAVORITE PART OF MACADDICT?

o
r
us
h

Here are the results
of our February 2006
survey. Check out
www.macaddict.com
each month for a
new online poll.

Since everyone is so security-conscious these days, when
one of my drives failed, it caused a perplexing problem: If
it’s failed, how do I completely zero out the data so no one
can retrieve it? Hopefully this worked.—SharkB8
You jest, but some sciencey types claim that formatting
your hard drive isn’t enough, and that given enough time
and some fancy equipment, hard-drive forensic detectives
can ﬁgure out what an “erased” bit on magnetic media
used to be. Some folks advocate the Guttman Method
for erasing data (which involves writing and rewriting
35 different patterns of bits), but your way’s probably
easier.—Max

8%

Feature articles

Get Info news

8%

Letters
and Shut Down

Reviews

8% I’m a Web
freeloader—I don’t
read the mag.

How-Tos
783 respondents

Introducing the eyePod.
(Sorry, would-be caption
writers, but you’ll have to
do better than ours.)

TENTING TONIGHT
How-To Editor Niko
Coucouvanis removed any
doubt about his affection for

me

WRITE TO US!

MacAddict, 4000 Shoreline Court, Ste. 400,
South San Francisco, CA 94080
or letters@macaddict.com

PVC and sheer nylon when
he titled his article, “Pitch
a Tent for Better Macros”
(Apr/06, p62). Tone it down,
you bad boy!—Warren Cann
Try to imagine what the
article looked like before we
edited it. But Niko’s settled
down a bit, now that he’s
a married man. Be sure
to check out his “Build a
Better Bride from Polyvinyl
Chloride” how-to next
month.—Max

HYBRIDIZED
Further proof that the folks
who use Macs will stop at
nothing to truly embrace the
digital lifestyle: This is my
friend Jeremy’s Prius; look
what he did to the screen
built into the dash!
—Herb Goodfellow Jr.

Macintoyota.

HYPER-BOLIZED
In “iLife on Intel” (Mar/06,
p18), you say that the Core
Duo chips in the new Macs
take advantage of Intel’s
HT (Hyper-Threading)
technology. But according
to Intel’s Web site, they
don’t.—Robert Tapia
Indeed, they do not—we
were a bit hyper-enthusiastic
when we wrote that, and we
hyper-goofed.—Max

According to Intel, the Core
Duos do a lot, but they don’t
do Hyper-Threading.
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FOR CD PROBLEMS:
go to www.futureus-inc.com
FOR SUBSCRIPTION QUERIES:
call (toll-free) 888-771-6222

CHINA SYNDROME
I applaud Editor-in-Chief
Rik Myslewski’s editorial
plain speech regarding
Google’s censorship of the
Internet on behalf of the
People’s Republic of China
(“Google Gagging,” Apr/06,
p10). Rik convincingly
stated the problems with
Google’s censorship and the
ramiﬁcations of extending
this attack on civil freedom
elsewhere—what works
in China certainly could
work here. C’mon, you civil
libertarians, step up to the
plate. Google is not your
friend. I might also add that
I’m writing this letter despite
my concern that continued or
future Chinese surveillance
of my communications
might jeopardize my
future efforts to work as a
journalist in that country.
If that sounds paranoid to
anyone, then that person
has not experienced and
does not comprehend the
true dimensions of a police
state.—Christopher B.

GO EASY ON GOOGLE
Ordinarily Rik is incredibly
detailed and insightful, but
he blew the call on Google.
Censorship in China isn’t
an abstract political or
philosophical notion—it’s the
law. How can Google do the
most good? By doing exactly
what it’s doing—providing
what services it can to a
population hungry for them,
and creating groundwork
such that, once a cultural
sea change occurs and
government censorship
ceases to be tenable to the
Chinese nation, Google is in
place to offer the unfettered
access that other global
citizens take for granted. I
share Rik’s censorship views
without question, but the
guilty party here isn’t Google.
It’s China.—Rich Pizor

WIN!
Win an iWoofer!

No, it’s not an alien spacecraft—it’s the iWoofer, a compact
speaker stand from Rain Design ($129, http://raindesigninc
.com). Not only will this cutie play your iPod tunes through its
two main speakers and downward-ﬁring woofer, it’ll also charge
and sync your ’Pod, let you listen to Terry Gross on its built-in
FM radio, and light up your life with its blue halo lamp. Want it?
Write the best caption to the image below, and it’s yours.
Only one entry per contestant.

Entry Form
Write a caption
for this picture.

CONTESTANT INFORMATION
Full Name:
Address:
City:

State:

Zip:
Email or telephone:
Send email entries to: contest@macaddict.com with the subject: iWoofer
(Don’t forget to include your address information!)
Send snail-mail entries to: iWoofer, MacAddict magazine,
4000 Shoreline Court, Suite 400, South San Francisco, CA 94080.
Deadline for entry: June 30, 2006.
Contest results will appear in our Oct/06 issue.
Contest Rules The judges will be MacAddict editors and will base their decision on 33 percent humor, 33 percent
originality, and 33 percent creativity. All entries must be received no later than June 30, 2006, with the winner
announced around October 2006. By entering this contest, you agree that Future US, Inc. may use your name,
likeness, and Web site for promotional purposes without further payment. All prizes will be awarded, and
no minimum number of entries is required. If two or more people enter identical winning captions, the entry
received ﬁ rst will be awarded the contest prize. Prizes won by minors will be awarded to their parents or legal
guardians. Future US, Inc. is not responsible for damages or expenses the winners might incur as a result of this
contest or the receipt of a prize, and winners are responsible for income taxes based on the value of the prize
received. A list of winners may also be obtained by sending a stamped, self-addressed envelope to Future US,
Inc. c/o MacAddict Contest, 4000 Shoreline Court, Suite 400; South San Francisco, CA 94080. This contest is
limited to residents of the United States. No purchase necessary, void in Arizona, Maryland, Vermont, Puerto
Rico, and where prohibited by law.

Winner!

Congratulations to
Rich Nixon, whose
caption we had to obey, and which won
him a Wacom 6-by-8-inch Graphire4 tablet
and mouse ($199.95, www.wacom.com).
And shame on the 37 percent of you whose
captions included
sly references to
Pick me! Pick me!
micturition.
I wrote the best caption!

Volume 11, Issue 6

MacAddict (ISSN 1088-548X) is published 12 times a year by Future US, Inc., 4000 Shoreline Court, Suite 400, South San
Francisco, CA 94080. Periodicals Postage Paid at South San Francisco, CA, and at additional mailing offices. Newsstand
distribution is handled by Curtis Circulation Co. Basic subscription rates: one year (12 issues + 12 CD-ROMs) U.S. $39.90,
Canada $43.95, U.S. prepaid funds only. Canadian price includes postage and GST 128220688. IPM 0962392. Outside the
U.S. and Canada, price is $53.95, U.S. prepaid funds only. POSTMASTER: Send address changes to MacAddict, P.O. Box
5126, Harlan, IA 51593-0626. Future US, Inc. also publishes Maximum PC, PC Gamer, Official Xbox Magazine, PSM, Guitar
World, Guitar One, Guitar World Acoustic, Bass Guitar, Guitar Legends, Future Music, Future Snowboarding, Snowboard Journal,
Snowboard Trade News, Skateboard Trade News, and Scrapbook Answers. Entire contents copyright 2006, Future US, Inc.. All
rights reserved. Reproduction in whole or in part is prohibited. Future US, Inc. is not affiliated with the companies or products
covered in MacAddict. Ride-Along enclosure in the following edition(s): A3, B, B1, B2, B3. PRODUCED IN THE UNITED STATES
OF AMERICA. Publications Mail Agreement #40043631. Returns: 4960-2 Walker Road, Windsor ON N9A 6J3
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SHUT DOWN

don’t let the back page hit you on the way out

Class of ’76

On the eve of Apple’s 30th anniversary back on April 1st, we dusted off our old yearbook
and waxed nostalgic about where we were 30 years ago—and discovered that the more
things change, the more they stay the same.
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© 2006 Network Solutions, LLC. All rights reserved.

Windows or Unix, we have everything you need to build and host a successful Web site, including
database access and lots of storage, data transfer and e-mailboxes. Backed by a 30-day limited
money back guarantee and toll free, 24/7, Real-Person Customer Service™ consultants. Call or
visit us to learn more, and to find out all the ways we can help take your business farther.
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HIP TO BE SQUARE.

GET HIGH CAPACITY STORAGE THAT FITS IN THE PALM OF YOUR HAND. DESIGNED BY KARIM RASHID AND
ENGINEERED BY LACIE, THIS TINY PORTABLE HARD DRIVE PACKS 30GB OR 60GB FOR TRANSPORTING
YOUR FILES, PHOTOS AND MUSIC IN STYLE. SINCE IT’S USB 2.0-BUS POWERED, JUST PLUG IT INTO YOUR
LAPTOP OR DESKTOP COMPUTER FOR EASY BACKUP AND TAKE IT WITH YOU ANYWHERE. WWW.LACIE.COM
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